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Introduction 

Introduction 
This book is aimed at a whole range of Mac users. It starts with the 

very basics - how to use a mouse, and finding your way around the 

Desktop - all the information that absolute beginners need to know. It 

also has information for more experienced Mac users - how to use the 

Apple menu, getting the most out of ahases, efficient ways of handling 

files and folders and the low-down on control panels and the System 

itself. Even 'Mac pros' may learn things they didn't know before - for 

example, the mysteries of the Apple Extras folder with System 7.5, 

what AppleScript does and whether to install QuickDraw GX... 

What we had to assume 
We couldn't produce a guide for every single version of the System 

running on every single model of Mac. Much of the advice and 

information in this book applies throughout the Mac range, and 

although it concentrates on System 7.5, a lot of this information is 

general. And who knows, if you don't already have System 7.5, you 

may be persuaded to upgrade! 

What we had to leave out 
This isn't a book for serious, heavyweight Mac professionals (although 

even they might learn a trick or two). It's for ordinary home or office 

users who want to understand and use their machine that much better. 

For that reason we steered clear of networking - it's a complicated 

subject that's only going to be relevant to a small number of people. 

We also had to leave out advice on hardware and software, just 

because there wasn't space to include it. 

What we’ve crammed in 
For all the things we had to leave out, we like to think we've stuffed a 

lot more in! In 100 pages it's tough to explain the Macintosh from the 

ground up, catering for both complete beginners and experienced Mac 

owners - but we think we've made a pretty good effort! 

We hope you like it. 
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1: Macintosh basics 

This chapter is for people who have never used a Macintosh 

before. It starts with what you see when you first switch on 

your machine, and by the end you should be able to find your 

way around. If you've used a Mac before, you don't need this chapter. 

If you've never used a computer at all, your Macintosh will give 

you the simplest, most painless introduction to computing possible. If 

you've used another machine, your Mac will make you wonder why 

all manufacturers don't make computers this easy to get to grips with. 

What’s an Operating System? 
To start with the very basics, your Macintosh has both a 'body' and a 

'brain'. The body is the hardware on your desk - the main box, the 

monitor, the keyboard and the mouse. None of this is any use, though, 

without the Mac's 'brain'. This is the software that works with the 

hardware to display documents on the screen, moves the pointer when 

you move the mouse, stores your programs and files so that you can 

find them again and a hundred more 'invisible' tasks that you 

wouldn't usually be aware of. This 'brain' is, to use the proper 

computing jargon, the 'Operating System' - it controls how your 

Macintosh 'thinks'. 

All computers have their own operating system, and this is what 

differentiates one machine from another. Macintoshes have their own 

operating system, PCs have theirs (the new Windows 95 is very much 

like the Mac's operating system) and other computers like the 

Commodore Amiga and Atari ST have different operating systems too. 

These days, though, the PC and the Macintosh are the two main 

computer types to choose from. 

Why don't all computer have the same operating system? The 

reasons are historical and commercial. At different times, different 

computer manufacturers have looked at the opposition and decided 

they could build something better - something that7s easier to use, 

nicer-looking or more efficient. That's all very well, because it ensures 

that computers 'evolve' in a spirit of competition. However, there are 

two drawbacks: 

1. Macintoshes are different to use to PCs (and other types of 

10 From the makers of Macformat 

What’s an Operating System? 

computer). You have to learn how to use each machine differently 

- they display information differently, and they are controlled 

differently. 

2. Programs designed to run on a Macintosh won't work on a PC, 

and vice versa. 

Called simply the System, the Mac's operating system is actually a 

complex and powerful piece of software that contains many features 

you can modify to suit the way you work - from how things look on 

the screen, to where your files are stored and how easy it is to load up 

the programs you use most often. There have been many versions of 

the System, and the latest - System 7.5 - is the most powerful and 

flexible to date. 

The part of the System you actually see is the Macintosh's 'Finder'. 

The Finder is a program that helps you find and organise your files 

and programs, and it's always running. The Finder is what you see 

when you first start up your Macintosh, and you can always switch 

back to the Finder while you're working with another program. The 

Finder is basically your Mac's control centre, and this is what it looks 

like (the details may vary from one Macintosh to another, but the main 

components are the same): 

r 4 File Edit Oiaw iaftel Special Q ® 83 0 

. .fife 
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1: Macintosh basics 

Not much to see, is there? This is the 'Desktop', and it's very much 

like the surface of your own desk might be. 

Using your mouse 
But before you start experimenting with the Desktop, there are some 

techniques you need to learn. Most of the things you do on your 

Macintosh are controlled with the mouse. As you move the mouse 

around on a flat surface, you'll see a small pointer moving about on 

the screen: ^ 

You make things happen by moving this pointer to the right place 

and then using the button on top of the mouse. Now, there are three 

ways of using this button: 

1. Single-Clicking. Where you are asked to 'click' on something, move 

the mouse pointer to the right place and press once on the button. 

2. Double-clicking. The same as single-clicking, except that you have 

to press the button twice in rapid succession. (This can be hard for 

beginners initially, but it comes with practice.) 

3. Dragging. Here you have to position the mouse pointer, then press 

the mouse button - and keep it pressed while you move the mouse 

pointer. This technique is used when you use 'menus' on the 

'menu bar' (see below) and when moving icons from one place to 

another (e.g. dragging an unwanted file to the Wastebasket). 

The menu bar 

r 4 File Edit Uleai Label Special_Q &i D 

Along the top of the Desktop is the 'menu bar'. Menus are lists of 

commands you can give that become visible when you move the 

mouse pointer over them and hold the mouse button down. 

To select one of the commands (the proper term is 'options') you 

just move the mouse pointer until that option is highlighted 

underneath it, and let go. 
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The menu bar 

Special 

Clean Up Desktop 
Emptg UJastebasket... 

Eject Disk_Ml 

Erase Disk... 
- 
Restart 
Shut Down 

For example, the Erase Disk... option (above) deletes all the 

information stored on a floppy disk inserted in the disk drive 

(obviously, it only works if there's one inserted). Some of the options 

on the Desktop menus won't make sense right now, but that doesn't 

matter for the time being. 

Most programs you run on your Macintosh have a menu bar 

(although some, such as multimedia products and games don't - or ' 

don't always display it), and it's always displayed right at the top of 

the screen. All menus work in the same way, too - you position the 

mouse pointer, click on the menu name and, still holding the mouse 

button down, move the mouse pointer down to the option you want, 

so that it turns black (it7s 'highlighted') and then let go. 

You'll notice that there are half a dozen named menus in the 

Desktop's menu bar, together with an array of symbols. You can click 

on these symbols to do a variety of things. You will probably see just 

three on your Desktop: 

ft The 'Apple menu' (far left). This is a special menu which you 

W can set up yourself to offer short-cuts to your most-used files or 

programs, amongst other things. It also offers quick access to the 

settings that control the way your Mac works and lets you access 

the small programs, like the Calculator and the Puzzle, that 

come with your Macintosh. 

2S 
The 'Help' menu (towards the far right). Most programs come 

with 'on-line help' so that you can call up screens containing 

advice, definitions and instructions while you're working. 
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1: Macintosh basics 

The Applications menu (far right). Your Macintosh can work on 

many things at once. We mentioned earlier that the Finder is 

always running, and you can go back to it at any time by 

selecting it from this menu. When you're working with a 

program, this icon changes to one that represents the program, 

but it still works the same way - any time you want to get back 

to the Finder (your Desktop) or another program, simply choose 

it from the list that appears when you click on this icon. 

The menu bar in the main illustration on page 11 contains a 

® ® couple of additional icons. Don't worry about these. Some 

programs create menu bar icons like these so that you can access the 

programs quickly at any time — another valuable short-cut for more 

experienced Mac users. 

A closer look at menu options 
If you browse around the Desktop menus, you'll notice that not all of 

the menu options look the same. 

For a start, not all of the menu options 

you see are in black text - some are grey. 

When an option is grey (or 'greyed out7, to 

use the proper term), you can't select it. 

This is because not all menu options are 

necessarily appropriate or possible at any 

one time. For example, if you try to empty 

the wastebasket (described on page 18) 

when there is nothing it, you'll see that option is greyed out. In this 

same menu you'll see that the Eject Disk option is greyed out - that's 

because there isn't a disk currently inserted. 

On the File menu you'll notice that (as well as options that are 

greyed out), many of the options are accompanied by symbols. For 

example, the New Folder option has a small symbol followed by a 

capital 'N'. This symbol is the one you find on your keyboard's 

'command' key (which often has an apple on it too). The command 

key offers short-cuts to many options you find on menus, and in this 

case, holding down the command key and pressing the 'N' key will 

Special 

Clean Up Desktop 
Empty Wastebasket.,. 

Eject Disk . XZ 

Erase Disk... * 

Restart 
Shut Douin 
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A closer look at menu options 

have the same effect as choosing the New Folder option using the 

mouse. Many of the options on the File menu have these 'keyboard 

shortcuts', and they can save more experienced Macintosh users a lot 

of time. Because they're always visible when you use the menus, you 

quickly get to learn them without having to try - soon you'll find you 

stop using the menus for many tasks and rely on these shortcuts. 

Try Edit bleu > La 

New Folder 

Open 380 

Print *P 

Close Window 38 UJ 

Get Info 381 

Sharing... 

Duplicate 380 

Make Alias 38M 

Put Away 38V 

Find- 38F 

Find Again 38G 

Page Setup- 

Print Desktop. 

Still on the File menu, you'll see that a couple of 

the options are. followed by three dots (...). These 

are continuation marks, and they are a kind of 

visual shorthand to let you know that these options 

lead to dialogs. We'll be looking at dialogs shortly, 

but basically they are devices that ask you for any 

extra information the Macintosh needs before it can 

carry out the command you've selected. 

FI 
File Edit Style Item Pagt 

ibout QuarkHPress!!

Lastly, take a look at the Apple menu. If 

you have System 7.5 installed on your 

machine, you'll see some options with 

right-facing arrowheads. This means that 

if you choose these options, a smaller 

'sub-menu' will pop up alongside, giving 

you a further range of options to choose from. To select one, just move 

the mouse pointer over to this sub-list, without releasing the button. 

Adobe Photoshop!!3.0 alias 

Adobe® PageMaker® 6.0 

© AppleCD Audio Player 

CD Automated Tasks !!

H Calculator 

Shutting down 
This is the first menu option you need to memorise! Take a look at the 

illustration of the Special menu on the previous page, and the last 

option - Shut Down. When you want to switch your Macintosh off, 

ALWAYS choose this menu option first so that it can close down its 

disk drives properly and check for any unsaved data. 

Talk to me! 
Many of the options you select from menus will need you to supply 

further information. For example, if you want to open a word 
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1: Macintosh basics 

processing document that you've been working on previously, your 

Mac is going to need to know what it's called and where to find it. 

Your Mac gets this additional information in the form of a 'dialog' 

(the American spelling is obligatory. I'm afraid). A dialog is like a 

form, where you have to fill in the right information in the right 

places. Here's the dialog that the ClarisWorks program displays when 

you try to open a file. 

ISILIUE !!| cd Hard Disk 

|j|^ Feature ideas | k> ( Eject ) 

""CiIZjnjRHyKjBHnGraBai f Desktop ) 
QMF31 

CDMF32 
— 

C3MF33 k [ Cancel ] 

£3 PENDING 

!&• Feature ideas template <> (( open )l 

Document Type File Type 

|flll Types |flll Ruailable !] 

It may look complicated, but it breaks down into pretty easy-to- 

understand segments. The main part of this dialog is a mini-window 

which lets you choose which file to open. (It also displays folders 

which you can double-click on to see if the file you want is within 

them.) You'll see this mini-window often when you're handling files, 

and there are other items in this dialog you'll see repeatedly too: 

At the bottom of the dialog are two options - Document Type and 

File Type - which are peculiar to ClarisWorks, and you don't need to 

know about right now. However, the downward-pointing arrows after 

All Types and All Available indicated that there are choices to make. 

___ When you see a box like this, with a downward- 

|<—>Hard Disk pointing arrow, it indicates a 'pop-up' menu. If you 

click on this box and hold the mouse button down, a menu appears 

which contains a preset range of choices for you to make a selection 

from. Pop-up menus can help you decide where to save a file, choose 

the type of file you want to create and more. 

Meanwhile, on the right hand side of the dialog you'll see a 
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Talk to me! 

column of 'buttons'. (Buttons are objects you click on once to make 

something happen.) The top one (Eject) is greyed out, meaning that we 

don't have a disk inserted. The next (Desktop) is a shortcut back to the 

top level of your filing system, which is useful if you get lost. The 

third button (Cancel) stops the whole operation and the dialog 

disappears. There's a Cancel button on just about every dialog you'll 

meet, you'll be pleased to here. Finally, there's the OK button. You 

click on this when you're satisfied you've chosen all the other options 

correctly. 

You'll notice that the OK button has a heavier border. This is a 

useful short-cut in dialogs. Pressing the Return key is the same as 

clicking on whichever button in a dialog has the heavy border (there 

will only ever be one). Quite often you'll open dialogs that you don't 

need to make any changes to, and pressing the Return key is quicker 

than moving the mouse pointer and clicking. 

^ Nearly all dialogs will have at least an OK (or Open, or 

([ Open ^j) gave) or a Cancel button and many dialogs will have 

[ Cancel ] additional buttons. 

There are three other types of object you'll meet in dialogs which 

aren't illustrated in our ClarisWorks example (above): 

Saue current document as: !s box is called a 'field' Fields are used 

where you, the user, need to enter a name 

for a new file, for example. Dialogs often 

fill in these fields with standard text which you can change. When the 

text, as in this case, is highlighted, you can start typing straight away 

and what you type will replace the highlighted text. 

!!Preuiem: 

Preuieui: 

This is a 'checkbox', shown in 'unchecked' and 'checked' 

state. It's like ticking a box on a form to say if you want 

something or not. To check or uncheck a checkbox, 

simply click on it. 

® Printer 

OFile 

These are 'radio buttons'. You find them in groups of two 

or more, and they let you choose one out of a related set of 

options. They are used where one response has to be 
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1: Macintosh basics 

chosen out of several possibles - rather like multiple- 

choice questions. 

The Desktop 
Having got the menu bar out of the way, we can turn our attention to 

the rest of the screen. This is the Desktop, and in our example it7s 

pretty bare. There's simply an icon in the top right called 'Hard Disk' 

(it may be called something different on your machine) and on in the 

bottom right called 'Wastebasket'. 

The Hard Disk icon on your machine will not look exactly like 

this one (that's one of the beauties of the Mac - you can 

change the names and the appearance of icons to suit your own taste), 

but your Desktop will have an icon that represents your machine's 

internal hard disk. 

The hard disk is where everything on your Macintosh is stored - 

your programs, your files, and all the files your Mac needs to run 

(we'll talk about programs and files shortly). You will often see 

desktops with many more icons, but these all represent items stored on 

this hard disk. Think of your hard disk as a 'box'. You can take things 

out of this box and leave them on your Desktop if you like, just to 

make them easier to get at. However, this is an illusion - they are still 

stored on the hard drive. 

! The Wastebasket is where you put all the things you don't 

want any more. In older versions of the System, this 

wastebasket would be emptied periodically, but now you have to tell 

the Mac when you want it emptied (choose the Empty Wastebasket 

option on the Special menu). This provides a bit more security - it's all 

too easy to throw things away accidentally. You can tell when your 

Wastebasket has something in it because it visibly bulges! 

Getting back to the Desktop 
Those, then, are the components of your Mac's Desktop. It's the place 

where you organise your files and information, and it's the starting 

point for all your activities. 

And because it's so central to everything you do on your 

Macintosh, it's helpful to be able to get back to it when you need to. 
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Getting back to the Desktop 

We mentioned earlier that your Mac could run several programs at 

once, and each program you run will take over the screen. It will put 

its own menus in the menu bar, and almost certainly cover up much of 

your Desktop. This can be confusing if you don't know what's going 

on. Think of your screen in terms of layers. At the bottom layer is your 

Desktop, while on top of it you can have one or more programs 

running, in the same way that you might have one or more books 

open on a proper Desktop, one on top of the other. 

This is where the applications menu (mentioned earlier) is so 

useful. Unlike most of the menus, it's always there, and you can use it 

to switch quickly between 'applications' (which is what Mac people 

call programs). When you choose a program from the menu, it brings 

that program to the front of the heap. 

If you want to get back to your Desktop, simply choose Finder 

from the applications menu. However, the display will probably still 

be cluttered partially by other applications you have running. So, from 

the same menu, now choose Hide Others - your Desktop is now 

clearly visible. 

Looking through windows 
Most of the things that happen on the Macintosh happen in Windows. 

You can see an example of a window if you move the mouse pointer 

and double-click on your hard disk icon: 
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1: Macintosh basics 

This will show you what's stored on your hard disk (what you see 

will be different to this, but the same principles apply). Depending on 

how your hard disk is organised, you will probably see a whole bunch 

of 'folders'. 

Note that the window we've created has a title, which is the same 

as the icon we double-clicked on. Double-clicking on the icon was 

pretty much like saying 'let me see what's inside this'. 

Folder icons look like this. Sometimes programmers change 

L—J these icons to add a bit of style to their software, and Apple 

itself uses modified folder icons to indicate important folders (like the 

System Folder and Applications folder in the illustration above). 

Largely, though, they all share the same design. 

Folders, as you may have guessed, are only containers for other 

things. To return to our earlier analogy of your hard disk being a box, 

folders are boxes within boxes. You use them to keep related 

documents together and in a certain place. Using folders you can 

create a complicated but efficient filing system. As usual with filing 

systems, though, you may well be the only one who understands it... 

There will be more on folders and how you can organise your 

Macintosh in chapters three and four, but for now, let's return to 

windows. All Macintosh windows have the same basic structure. They 

are rectangular boxes that you can move about on the screen. You can 

also make them wider or shorter, and it's easy to arrange several 

windows on the screen so that they don't overlap each other. 

To move a window (like the one we created when we double¬ 

clicked on the hard disk icon), move the pointer to the title bar: 

j [i3 Hard Disk i3-| 

and, using the 'dragging' technique described on page 12 (holding 

down the mouse button while moving the mouse pointer), 'drag' the 

window to a new location (a flashing outline indicates the new 

position of the window while you're dragging it). Then let go of the 

mouse button, and your window is placed in its new position. 

The problem with windows, though, is that they are a finite size - 

regardless of the number of items they contain. So how do you make 

sure you can see everything? Well, there are two approaches: 
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Looking through windows 

1. lv,Do you see the little symbol at the bottom right-hand side of 

® the window? This is the resizing box. If you drag on this, you 

alter the position of that comer of the window, which means 

changing the window's size and proportions. Again, the outline of 

the window is shown as a dotted line until you let go of the mouse 

button. You can use the resizing box to make the window bigger or 

to fit it in with other windows open on the screen at the same time. 

But there may be so many things in the window that you still can't 

see them all even if you increase the size of the window. How 

would you know? Look to see if the window's 'scroll bars' are 

grey or white: 

see one along the bottom of a window and down the right hand 

side. If the scroll bar is grey (like this one), it means that the 

window isn't big enough to show you everything it contains - you 

can use the scroll bar to move the 'view' of the window's contents. 

Imagine looking into a large room through a small window, and 

having to keep changing your position to see into the comers of 

the room. You can use the scroll bar either by clicking (or pressing) 

on the arrows at either end, or by dragging on the scroll box (seen 

here at the left-hand end of the scroll bar). It's important to get 

used to scroll bars, because you'll be seeing them a lot. 

3. ij=|i There's an icon in the top right-hand comer of every 

window. If you've changed the size or position of a window, 

clicking once on this will restore it to the old one. Click again to go 

back to the new one. If you haven't re-sized the window, clicking 

on this will increase the size of the window just enough to display 

everything inside it (if your screen is big enough). 

4. Finally, look out for this icon in the top left-hand comer. This 

is the 'close box', and you click on this to close the window. 

All windows on the Macintosh share these features, and you 

handle them all the same way. If you use a word processing 
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1: Macintosh basics 

application, for example, your text document will appear in a window 

that you can resize, move and scroll around. 

Although you can have more than one window open at once, only 

one of them is 'active' at any one time. You can easily tell an active 

window from an incactive one by its appearance. 

Compare this picture of the Hard Disk window with the one on 

page 19. In this version, the title bar is plain white and all the gadgets 

used for manipulating windows - the scroll bars, the close box and the 

resize box - have vanished. This is because this window is no longer 

active - there's another window on the screen which is active. 

To make a window active, simply click on it once. The scroll bars 

reappear and you can now carry out the action you want. As you get 

more experienced, you'll find yourself regularly working with several 

windows open at the same time. 

Launching an application 
That's another way of saying 'running a program'. The Mac has a 

language all its own, and you do need to get used to it if Mac 

magazines and software manuals are going to make much sense. 

Anyway, we've looked at the Desktop, windows, menus, icons and 

dialogs, which is pretty well all there is to know about the Mac's 

operating system (or 'Finder', which is the visible part). The point of 

having a computer, though, is to use applications - word processors. 
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Launching an application 

drawing packages, business accounting programs and more. 

Launching Macintosh applications is easy. There are two ways: 

1 • rmva Every program on your Macintosh has an icon. This is 

the icon for ClarisWorks, a package that's pre-installed 

ciarisworks on most new Macintoshes now. To launch ClarisWorks, 

simply find the icon on your hard disk and double-click on it. 

2. There is an even easier way. Every document you 

create with a Macintosh program has a special 

MF book contents 'signature' that identifies it as being generated by that 

program. Documents usually have an icon like the application's 

icon, too. Not only are ClarisWorks documents, for example, easily 

identified, you can double-click on them to open them up. This is 

one of the cleverest aspects of the Macintosh - you don't need to 

know where applications are stored, because if you double-click 

on one of the application's icons, it will open up with the right 

application automatically - it will find the application for you! 

Once your application is running, what you need to do next 

depends on the application, and you should refer to its manual. 

Nevertheless, all the things we've looked at in this chapter - windows, 

icons, menus and dialogs - will work in the same way. 

Applications and documents 
'Application' is the proper Mac-speak for 'computer program'. An 

application could be a word processor, a drawing program or an 

accounts package. You use the application to create 'documents' which 

you can save and load up again another time. When you first switch 

on your Macintosh and 'launch' your application (Mac-speak for 

'running your program'), it loads from the hard disk into your Mac's 

memory before it starts working. And when you create a new 

document with that application, it stays in the memory until you 

'save' it. Don't forget to save your documents! Because when you 

switch off your computer, the memory is wiped clean. The same 

applies to any changes you make to existing documents already stored 
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on your hard disk - if you forget to save the changes before you shut 

down, you will, in theory, lose them forever. However, if you shut 

down your Mac properly, you get warned if you have any unsaved 

data, and it is hard to accidentally wipe it. 

You have to get organised when saving files, otherwise you'll 

never be able to find and open them again. When you're working on a 

document, you'll find the Save option on the File menu. It's a good 

idea to save your document now and again even if you're still working 

on it. When you choose the Save option, it updates the file on your 

hard disk with all the changes you've made since the last Save. And 

since Macintoshes occasionally 'crash', 'hang', or 'freeze' (in other 

words, they lock up solid and won't work until you switch them off 

and restart them - thereby losing the contents of the memory), regular 

Saving will mean you're less likely to lose work as a result. 

As well as a Save option, your file menu will also have a Save 

As... option. This is so that you can save your file with a different 

name. If you're experimenting with changes to a letter, for example, 

and don't want to lose the original, choose Save As... and then pick 

another name. This will leave you with two files on your hard disk - 

the original, and your experimental version. 

Basically, though, there is one message that applies all the time 

you're working on your Mac. SAVE, SAVE, SAVE...! After a while, it 

becomes a conditioned reflex to hit the command-S keyboard 

combination (universal shorthand for Saving the file you're working 

on) in idle moments. 

Expert tips 
• If you drag an item to the Wastebasket and then change your mind 

about deleting it, double-click on the Wastebasket to open it, select 

the item and then hit command-Y. This puts the item back where it 

was before. 

• Some multimedia titles and games don't display their menu bars 

while they're running a sequence or in certain modes. If you need 

the menu commands, try tapping the spacebar, clicking the mouse 

button or hitting the Esc key. 
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Now that you know the Macintosh basics, it's time to explain 

the difference between your computer's 'memory7 and the 

information it can store. 

Human beings both think with and remember with a single device 

- their brains. Computers aren't like that. They think with their 

'memory' (yes, confusing, isn't it) but they store information on their 

internal hard disk. 

When you switch your Macintosh off, its memory is wiped clean 

(it needs continuous electrical power to work). This means that you 

have to make sure whatever you were working on is stored on the 

hard disk before you switch off. When you switch your Macintosh on, 

it has to load its own operating system off the hard disk into its 

memory before it can work at all. Think of the hard disk as a filing 

cabinet and the memory as a working space which gets cleared 

whenever you leave (and the contents thrown out if you haven't filed 

them!) 

Both the Macintosh's memory and its hard disk can handle a fixed 

maximum amount of data, depending on the machine's specification. 

And data is measured in Kilobytes (K) and Megabytes (Mb) - a 

Megabyte is 1,000 Kilobytes (strictly, it's 1,024 Kilobytes). 

Macintoshes are sold with anything from 4Mb to 16Mb or more of 

memory, and hard disks that can store from 250Mb to 1,000Mb or 

more of information. To put this in perspective, a word processing 

program might take up about 10Mb of storage space on the hard desk, 

and need about 2Mb of memory to work in while you are using it. The 

text of a 300-page novel would take up only about 300-500K, while an 

illustrated book like this one might take up 15Mb. 

Both the amount of memory your machine has and the size of its 

hard drive are important. The hard drive size tells you how much 

information you can store, while the memory size governs the 

complexity of the work you can do. Some programs require a great 

deal of memory to run. There is a program called Adobe Photoshop, 

for example, (used to touch up photographs for publication) which 

needs 16Mb of memory - or more - to work properly. 

Memory is more usually called RAM, and it's a fact of life that few 

Mac owners have enough RAM. RAM is expensive to manufacture. 
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and machines are usually shipped with the minimum amount to cut 

costs. You can increase the amount of RAM in your machine, though - 

speak to your local Mac dealer about the options. 

RAM, megabytes and hard disks are all central computer concepts 

- now you know what they mean. Soon they'll be peppering your 

every sentence... 

Your Mac’s processor 
So we know that a Mac stores information on its hard disk, and that it 

works with it in its memory - now we need to look at the 'processor'. 

Note that you'll also see the processor described as the CPU 

(Central Processing Unit) or even 'chip' (after 'silicon chip'). 

The processor is your Macintosh's engine. The operating system 

uses the processor to carry out the countless millions of instructions 

necessary to perform even the simplest-looking task. While the 

operating system give's the Mac its identity, or personality, the 

processor governs its raw speed. 

There are many Macintosh models on the market, and they use a 

variety of processors (even though they are all related). The simplest 

way to break Macintoshes up into categories is to doing it according to 

chip type, and there are two families: 

1. PowerPC Macs. These are the latest models, and they use a brand 

new type of processor - the PowerPC - which is a lot faster than 

the older types. However, Apple have made sure that all the 

existing Mac software, printers and other gadgets work with the 

new machines, and the operating system looks just the same, and 

is the same to use. Most users won't notice any difference, apart 

from the extra speed. 

2. Non-PowerPC Macs. These are older models which use processors 

manufactured by Motorola. This family of processors started way 

back in the 1980s with the 68000 model. Soon there was a faster 

version - the 68020, followed by the even-faster 68030 and finally 

the quickest of them all, the 68040. Machines based on the 68040 

are not a lot slower than the cheapest PowerPC Macs, and because 
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Apple have only recently stopped making them, you can pick up 

some excellent bargains from the mail order companies which 

advertise in Macformat magazine. 

On the whole, the processor type is the single most useful guide to 

the speed and power of a Macintosh. There are a couple of secondary 

considerations, though: 

1. 'Clock speed' is the rate at which a processor carries out its myriad 

calculations per second. The clock speed is measured in cycles per 

second (the processor 'oscillates' like the crystal in a quartz watch) 

- or MHz (MegaHertz). For example, the 68030 processor has been 

made available as a 25MHz model and a 33MHz model. 

Macintoshes with the 33MHz model are approximately 30% faster. 

Having said that, the 'slowest' 68040 processor is still faster than 

the fastest 68030 model. Generally, the slowest model of any new 

processor is faster than the quickest version of the previous one. 

2. RAM, or memory, is also a vital ingredient in speed. Many 

programs require a great deal of RAM to work efficiently. If they 

don't get it, they have to keep shuffling data from the hard disk 

into memory, and then back to the hard disk again to make room 

for fresh data. Moving data to and from the hard disk is slow, and 

having too little memory can ultimately slow you down far more 

than having a Macintosh with an 'old' processor. Before you 

upgrade your Macintosh to a faster model, make sure that the 

speed problems you're encountering aren't due to a lack of RAM. 

One easy check is to keep watching your hard disk light while 

you're using your applications, and to watch out for pauses when 

the display 'freezes' up for a few moments. These are signs that 

the Mac is having to access its hard disk. This is normal when 

loading files stored there, but not when you're in the middle of 

working on one. 

Although non-PowerPC Macs will soon become hard to buy, there 

are so many in circulation that software manufacturers will be 
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producing software for them for a long time to come. However, 

because the PowerPC processor works in a very different way to the 

older type, software designed specifically for it is much quicker than 

software designed for the older processors, so manufacturers are 

increasingly producing versions of their programs specifically for 

PowerPC-based Macintoshes. These are called 'native' applications. If 

you have a non-PowerPC Mac, applications described as 'native' will 

not work. If you have a PowerPC Mac and you are offered a choice 

between a '68xxx' version and a 'native' version of a program, go for 

the 'native' version. 

Mac-spotting 
Macintoshes are usually sold in two forms: standard machines and 

'Performas'. Performas are Macs specially designed for more 

inexperienced users and those using their Mac at home rather than in 

business. They are sold as complete packages, with practically 

everything you'll need to get started, and come with extra software 

and help for beginners. The standard machines, on the other hand, 

may be more 'expandable' - it can be easier to add specialist hardware 

later on, and you have more choice over the equipment that comes 

with your machine. 

There are too many different models and variations to list them all 

here, but with the help of this brief overview you should be able to 

recognise most types and decipher the specifications printed in 

magazines. 

Expert tips 
• If memory's tight, you can save it by carefully running through your 

System Extensions (there's more on Extensions in chapter six). Using 

Extension Manager (included with System 7.5) or a third-party 

Extensions utility, you can pare down your extensions into minimal 

sets for specific jobs (if you're using a paint package, for example, 

you can probable manage without Adobe Type Manager, which is 

very RAM-hungry). 

• Although PowerMac-native versions of applications need more 

RAM than their 680x0 versions, a design quirk of the PowerMac 

The Alternative Mac Manual 29 



2: Memory, hard disks and Macintosh models 

means that switching on virtual memory makes the machine handle 

applications differently - they require a much smaller RAM 

allocation, frequenly half as much. With 1Mb of virtual memory 

allocated, QuarkXPress, for example, runs in as little as 1.6Mb on a 

PowerMac. 

• On 680x0-based machines, don't use virtual memory if you can 

avoid it. You need all the speed you can get, and shuffling data that 

should be in RAM to and from your hard drive is highly inefficient. 

If you really can't afford the extra RAM, get hold of a copy of the 

excellent RAM Doubler from Connectix - it really does work, and 

with a minimal speed penalty. 

• Beware of RAM fragmentation! If you keep launching and quitting 

applications, your available RAM will get broken up into useless 

little segments - and applications need contiguous RAM to load 

into. If you hit unexpected memory problems, quit all your 

applications, then launch them all again - this will make them fill 

up the available memory without any 'gaps'. 

• If you're having trouble running older applications, it could be that 

they're not '32-biP clean. The Mac's OS is fully 32-bit these days, but 

older software may have been written in the old days of 24-bit 

addressing. If you're running System 7, turn off 32-bit addressing in 

the Memory control panel and try again. If you're running System 

7.5 - tough. Time to buy some new software. 

• Opinions are divided about the Disk Cache (Memory control panel). 

This is a segment of RAM that stores the last block of data taken 

from the drive on the assumption that it's quite likely to be needed 

again shortly. Everyone agrees that's a good idea, but what's not so 

well-known is that not everyone agrees the Mac's caching system is 

terribly smart. If you need more RAM, reduce the Disk Cache 

setting to 128K or even 64K. Many of the newer processors have 

their own caches, and some software has its own caching systems 

(interestingly, Photoshop and the Mac's Disk Cache can conflict 

badly). 
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Once you've started creating your own documents, it won't be 

long before you realise you need a proper, organised filing 

system for them. At its most basic level, the Macintosh has a 

very simple way of organising things. Items on your hard disk are 

either files (which could be applications, documents or other 

miscellaneous items) or containers (in other words, folders). You can 

put folders within folders to your heart's content, and you can call 

these folders what you like. And because documents you create can 

automatically 'find' the application that created them, you can 

basically put your documents anywhere you like. 

‘Files’ and ‘documents’ 
But it's as well right now to clear up one possible source of confusion. 

The term 'files' is a catch-all term to describe anything that's not a 

folder, basically. A file can be an application (program), it can be data 

used by the System, it can be information stored by applications for 

.their own needs - and it can be a 'document7. The term 'document7 is 

jused in this book to describe files created by the user - you might have 

a word processor document, for example, or a database document. All 

documents are files, but not all files are documents... many 

applications create files that aren't designed to be seen by the user. 

These files can contain information on how the application is set up on 

your Macintosh - so-called 'Preferences' files. Applications can come 

with a whole host of 'support7 files, like dictionaries, additional tools 

and functions and maybe on-line help. And - importantly - the 

Macintosh's operating system consists of many files which have to be 

kept in the right place and left untouched. These are all located in the 

System Folder, which you should only interfere with once you know 

what you're doing (see Chapter six). 

Although certain files must be kept in certain places (this is 

usually handled automatically), everything else - your documents and 

often the applications themselves - can be stored where you like. 

Moving things around 
You can move files and folders around at will from the Desktop. We've 

already seen how double-clicking on a folder opens up a window that 
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shows you the contents of that folder. Well you can move any of these 

contents from one place to another simply by 'dragging' it to its new 

location. 

To do. this, first position the pointer over the folder or file you 

want to move (don't forget you need to click once on that window to 

make it the active one, if it's not active already). Press down on the 

mouse button, and the folder/file will highlight (as above). Now, with 

the mouse button still pressed down, move the pointer to where the 

folder/file should be moved to - it will take a faint outline of the 

folder/file with it so that you can gauge the final position. 

Then simply let go of the mouse button, and your folder/file will 

have been moved. Usually, you'll be moving items from one folder to 

another, but it can be easier to move them to the Desktop first. Or, if 

you prefer, you can leave things on your Desktop permanently. It 

makes the Desktop more cluttered, but it also makes commonly-used 

items easier to find. 
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How do you create a new folder? 

Print 3!P 

Close Window 8!W 

Get Info %l 

Sharing... 
Duplicate 3£D 

Make Alias 36 M 

Put Rway 3!Y 

Find 36F 

Folders are simple to create. From the Desktop, 

choose the New Folder option from the File 

menu. This will create a new folder in the 

currently active window (or on the Desktop 

itself if you don't have any windows open). It7s 

as simple as that! The only thing is, the new 

folder is simply called 'untitled' - how do you 

change its name? 

What’s in a name? 
As well as being able to move folders and files around, you can also 

call them what you like - and it's very easy to change a name: 

Move the mouse pointer over the name of the object 

you want to rename and click once (the object will 

now be highlighted). 

If you wait a couple of seconds you'll see the icon 

change subtly. The label is now surrounded by a 

border... 

.. .which means you can now start typing in your 

new name (this must be less than 30 characters in 

length, but can include spaces). 

Once you've typed in the new name, simply click anywhere else 

on the screen and the new name is saved. 

Building an organisation 
The Macintosh's operating system offers so much flexibility, that it's 

hard to know how to start organising your hard disk. The main hard 

disk folder must contain the System Folder (which you should leave 

alone), but beyond that, you can do what you like. System 7.5, the 
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latest version of the Mac operating system, and the one supplied with 

all new machines, comes with two special folders for Documents and 

Applications. You may see these on the Desktop (remember that they 

are still stored on the hard disk - they've simply been 'left ouT. These 

are set up so that you know where to put and where to find 

Documents and Applications respectively. 

This is useful for beginners who are still struggling with the basic 

Mac concepts, but it is a little restrictive. While most of us will 

probably only have half a dozen or so applications, we may generate 

dozens - even hundreds - of documents, and clearly some higher level 

of organisation is needed. 

One solution is to create additional folders within the documents 

folder. You might have different folders for different jobs, or clients or 

applications. As a freelance writer. I've set up folders for each 

magazine I do work for, and within these folders are other folders for 

each issue, or each specific job I undertake. You might like to do 

something similar, although there are as many ways of organising a 

hard disk as there are different Macintosh users. In the next chapter, 

we'll be looking at more ways to organise your Mac. 

Other sorts of drive 
All of your Macintosh's data is held on its internal hard disk. It gets its 

name from its construction - a hard disk stores its data on a stack of 

rigid metal discs, and moving heads read off the data as the discs 

rotate. 

Floppy disks use a similar principle but in a cruder, cheaper form. 

They contain only a single, flexible disc (hence 'floppy') in a slim, rigid 

case. 

Hard disks can hold a lot more information than floppy disks. This 

information capacity is measured in Kilobytes (K) and Megabytes 

(1000K). A floppy disk can hold approximately 1.4 Megabytes 

(abbreviated to Mb), while a hard disk can hold between 40Mb (older 

Macintosh models) and 500Mb or more (newer models). 

All Macintoshes are equipped with an internal hard disk, and you 

can insert floppy disks into them too. You might copy a file to a floppy 

disk to give it to someone else, for example. 
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You can both move your files around and duplicate them in new 

locations. When you drag a file to another location on your hard disk, 

your Macintosh simply moves it to that new location. If you drag it to 

a floppy disk, though, being cautious, your Mac copies it over instead 

of transferring it (you keep the original file on your hard disk). This is 

an important general principle to remember: when you drag a file 

within a disk (either a hard disk or floppy disk) it gets moved; when 

you drag it from one disk to another, it gets copied. 

You can make copies of your files on the same disk, however. To 

do this, select the file by clicking on it once to highlight it and then 

choose the Duplicate option from the File menu. This will create a 

duplicate of the file in the same window, which you can rename if you 

want to. 

There is a third sort of disk drive. Although both hard disks and 

floppy disks store information on a magnetic surface (like audio 

cassettes), CD-ROMs store information optically (like a CD player). 

CD-ROMs are a special type of CD which store computer data rather 

than audio tracks. They have major advantages in computing: 

1. They can store vast quantities of information. A CD-ROM can store 

650Mb of data - more than most hard disks and 500 times as much 

as a floppy disk. 

2. They are durable. Although you can't drill holes in them or scrape 

them across floors, CD-ROMs are pretty resistant to damage 

providing you handle them carefully. 

3. They are inexpensive. CD-ROMs cost only a few tens of pence to 

manufacture. It's now possible for software publishers to sell 

much 'bigger' applications than was practical before and a single 

CD-ROM is much cheaper to manufacture and distribute than a 

box full of floppy disks. 

There is one major disadvantage for the end user, though. You 

can't store any information on a CD-ROM yourself - you can only read 

it. Data can only be copied to CD-ROMs during a complex and highly- 
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specialised manufacturing process. It is possible to buy CDs and 

special drives that let you store information of your own, but these are 

expensive and outside the scope of most users. The fact that CD-ROMs 

are 'read-only' doesn't matter greatly in the software market-place. 

They are ideal for multimedia products like talking encyclopaedias 

and games, and other products that feature animations, video 

sequences, high-quality sound and speech and special effects. All of 

these take up vast amounts storage space, and CD-ROM is the only 

medium which can handle them. 

Using other drives 
Other drives (like CD-ROMs and floppy disks) work in the same way 

as your hard disk. They have an icon you can double-click on to open 

a window showing the contents. And you can work down through 

layers of folders, just as you do with your hard disk. 

Your hard disk icon is always visible on your 

Desktop, but you won't see an icon for a floppy disk or 

a CD-ROM until you insert one (logically enough). 

This illustration shows my main hard disk icon (top), a 

CD-ROM (many Macs can actually play audio CDs, 

which is what this is) and a floppy disk (bottom). 

You can eject any disk (except your hard disk) by dragging it to 

the wastebasket. (This doesn't delete the contents of the disk!) 

Installing applications 
When you buy an application, you'll get a box containing a set of 

floppy disks, or maybe a CD-ROM. You have to copy the application 

and its associated files from these on to your hard drive before the 

application will work. Although we've already looked at how you can 

drag files from one drive to another, in the case of applications it7s not 

quite that simple. 

1. There are many different Macintosh models, and the software 

publishers need to cater for as many of them as possible. This 
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often means supplying more than one version of some of the files, 

and files that won't be needed for all machines. 

2. Although applications themselves can usually be stored anywhere 

you like on your hard disk, many of the files which go with them, 

and which they rely on, have to go in certain, very specific places. 

These can include System Extensions (we'll meet those in the 

chapter on the System), control panels (next chapter) and 

preferences files (which store set-up details for the application. 

To make life easier for everyone, the software suppliers include an 

'Installer' with their application. The installer is a mini-application in 

itself. You double-click on its icon (the instructions will tell you which 

disk to find it on) and it checks your Mac hardware to see which files 

will be needed, then copies the appropriate files to the appropriate 

location. Very clever. 

Once the installation is complete, you may be asked to restart your 

Macintosh. Don't worry, this is quite common. It simply means that 

the application has had to install some modifications to your System 

which will only come into effect if you shut down your machine and 

then start it up again. 

Expert tips 
• Macintoshes can read PC-formatted disks, but PCs can't read Mac 

disks. If you need to swap files with a PC-owning colleague, use 

disks that they have formatted or format them as PC disks yourself. 

If you have PC Exchange (with System 7.5) you can do this as an 

option when you select the Erase Disk... command, while if you 

have Apple File Exchange, launch it and format the disk from there. 

• SyQuest drives combine bulk external storage with a portable data 

medium. The 3.5-inch models are more compact, but the 5.25-inch 

models are the most commony-used. 

• If you have a SyQuest drive, get SCSI Probe - if you switch on your 

SyQuest drive after you start up your Macintosh, you'll probably 

need SCSI Probe to get your Mac to recognise the drive at all. 
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Once you've mastered the basics of using a Macintosh, you can 

start experimenting with the different ways in which you can 

adapt it to suit your needs and preferences. 

Window views 
One of the first things you can do is change the way items are 

displayed within a folder. Usually, new Macintoshes are set up to 

display items as icons. This is an easy-to-understand method that lets 

you quickly tell folders from files, and one type of file from another. 
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13 items 432.9 MB in disk 80.3 MB availabl 
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by Small Icon 

!!by Icon 

by Name 

by Size 

by Kind 

by Label 

by Date 

There are other ways of looking at the contents of 

windows, though. Click on the window you want to 

modify to activate it, and then click on the View 

menu to see a whole list of options. You'll notice that 

currently the by icon option has a tick next to it (left) 

- that means iti s the option currently selected. Try 

choosing the by Small Icon option instead: 
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Predictably enough, this has made the icons much smaller. They 

are a little harder to see, but you can see more in the window, meaning 

you either have to use the scroll bars less to see everything or you 

don't need to enlarge the window quite as much. 

Here's a quick tip. If your window isn't large enough to show you 

all the contents, click on the box at the far right-hand side of the title 

bar - this will enlarge the window to the right size automatically 

(assuming your screen is big enough). 

What about the by Name option - what does this do? 

This is the third way of looking at the contents of windows (all the 

remaining options are variations on this one), and itis arguably the 

most useful. As you can see, folders and files don't have icons any 
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more - they are simply displayed as a list. But this list can give you 

lots of useful information, like whether items are folders or files and, if 

they are files, the name of the application that created them. You can 

also find out how big your files are, and when you last made any 

changes to them. (The window illustrated above doesn't have any files 

in it, only folders, so some of this information is left blank.) 

In this view, files and folders are listed alphabetically, but the 

remaining options on the View menu can change this order so that you 

display items in order of the largest, or the most recently modified or 

by the applications that created them (useful for sorting out and 

separating your documents). You can also view them by 'label' - we'll 

look at labels on page 43. 

As well as the list of folder and file names, you'll notice right¬ 

pointing arrows at the start of each folder name (only folders, not 

files). These are very clever. You store things on your hard disk by 

creating folders within folders in a kind of nested structure according 

to your own organisational system. Normally, you might find a file by 

opening your hard disk window, then double-clicking on a folder 

within it, then another within that... until you 'work down' to the file 

you want. The View by Name option gives you another method. If you 

click on one of these right-facing arrows, it turns downwards, at the 

same time revealing, offset to the right, a list of all the contents of that 

folder. 

Name Size 

Hard Disk • . * 

Kind Label Last Modified 

> D ALIASES - folder Mon, Nov 6, 1993, 12:33 pm & 
» !!Apple Extras - folder Tue, Jun 6, 1995,4:03 pm 1 

D AppleScript** Utilities - folder Mon, Jul24, 1993, 10:14 am 

<& FaceSpan 391K application program - Thu, Mar 3, 1994, 12 OO pm 

> !!Face Span Demo Projects - folder Mon, Jul24, 1993, 10:14 am 

> !!Face Span Project Tempi... - folder Mon, vhil 24, 1993, 10:14am 

D FaceSpan Release Notes 17K Scriptable Text Edi... - Thu, Mar 3, 1994, 12.00 pm 

» CD FaceSpan Samples - folder Mon, Jul24, 1993, 10:14 am 

<9t Script Editor 179K application program - Fri, Sep 22, 1993,2:19 pm 

<3> Scriptable Text Editor 111K application program - Thu, Dec 9, 1993,2:30 pm 

» CD Scripting the Finder - folder Mon, Jul3, 1995, 11:07 pm 

t> CD User Release Notes - folder Mon, Jul3, 1995, 10:30 pm ± 
tLJ - r 1< 

This is another way of 'navigating' through the layers of folders on 

your hard disk. You'll see in the above illustration that the 
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Window views 

AppleScript!!Utilities folder contains both files and folders. The files 

have their sizes quoted, and the folders have right-facing arrows - you 

can click on these arrows too to find out what these folders contain. 

And so on, down to the file or files you are looking for. 

This is called an 'outline' view, and you may come across it in 

word processing documents. It's a way of organising things in an easy- 

to-understand hierarchy. Simply click on a downward-facing arrow to 

'close up' the outline again. With a little experimenting you'll quickly 

grasp how it works. 

Note that the changes you make with the View menu apply only 

to the current window. And you can still find files by successively 

double-clicking on windows to open them, or you can set up your 

hard disk window in View by Name mode and use the outline arrows 

to find the things you want without ever having to open another 

window. Or you can use a combination of both methods. That's the 

beauty of the Macintosh - there is always more than one way of doing 

something, and you can choose the method which suits you best. 

What’s a label? 
Labels are a rather under-used part of the Mac operating system. They 

are not useful to everyone, and most Macintosh users don't 

understand them too well. But you may find them a godsend. 

Kmmm wrml Click once on a file or folder to select it. Then 

K?!P"SDeC,al choose a label from the Label menu. If your window is 

set to either of the icon view you won't see any 

change in your file/folder. But if you switch to View 

by Name, you'll see that file/folder now has the label 

you chose. (If you can't see the Label column, increase 

the width of the window.) 

i Essential 

| Hot_ 

1 Cool * 

| Personal 

| Project I 

| Project 2 
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Now, if you choose the View by Label option for that window, 

your files/folders will be sorted out according to the labels you've 

given them. 

You're not stuck with the labels currently on the menu, either. You 

can change these via one of your Macintosh's Control Panels, and we'll 

be looking at these in the next chapter. 

Finding your files 
It's easy to create complex filing systems on your Macintosh - and as a 

result it can be easy to forget where you left certain files. Thankfully, 

there's a quick way of finding any file. From the desktop, choose 

Find... from the File menu. You'll then see this dialog. 

There are various options here for changing the way your Mac 

searches for files, but for now, we don't need to change any of them. 

Simply type the name of the file you're looking for (or even part of the 

name) in the box just above the Find button, then click on the Find 

button. After a few seconds, your Macintosh will have found all of the 

matching files, and will display them in the following window: 
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Finding your files 

This shows you two things. It shows you the names of all the * 

matching files and folders in the top part, and if you click on any one 

of them to highlight it, the bottom part shows you where you can find 

it (in other words, the route through the various nested folders). 

Note that you only see these dialogs if you have a newer machine 

with System 7.5. Older versions of the System have a less sophisticated 

Find... dialog which gives you fewer options. This older dialog only 

shows you the first matching file your Mac finds - to find any others 

you have to use the Find Again option on the File menu. 

For more information... 
There are other interesting options on the File menu. One of these is 

Get Info. If you highlight a file or folder and then select Get Info, 

you'll see a window like this one. 

PpMP MF book 02 info 

jjUpj MF book 02 

Kind: QuarkXPress!!document 

Size: 340K on disk (347,648 bytes used) 

Vhere: Hard Disk: EVERYTHING!: 

MACFORMAT: LIVE: MF BOOK: 

Created: Mon, Nov 6,1995,4:24 pm 

Modified: Tue, Nov 7, 1995, 11 :49 am 

Version: n/a 

Comments: 

I 

!!Locked !!Stationery pad 

This window tells you a lot more about the item you selected. At 

the top is its name, and below that you'll see what kind of item it is 

(this one is a QuarkXPress document - QuarkXPress is the application 

Macformat uses for designing the magazine). Below that is the size of 

the document, where it's stored, when it was first created, when it was 

last modified, its version number (not applicable to documents like 

this one) and - below that - a box where you can type messages to 

colleagues (or yourself) or any other information about the document 
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you like. Right at the bottom of the window are two check-boxes. Click 

on the box on the left and you 'lock' the file. This makes it impossible 

to delete or modify it until you open this window again and 'un-check' 

the box. The one on the right turns the document into an item of 

'stationery' - it becomes a template for other documents, so that you 

can open it and make changes to it, but you must save it as something 

different - the original template document is left intact. 

Creating short-cuts with aliases 
There's another interesting option on the File menu - 

Make Alias. Again, first select a folder or file, and then 

^ choose this option. This creates an 'alias' of the original 

item (you can tell it's an alias because its name is 

italicised). You can double-click on this alias to open the document or 

folder, in the same way that double-clicking on the original would. 

The difference is that you can leave the original where it is, for the 

sake of efficient organisation, but put the alias any where you like - on 

the Desktop, maybe, if you want quick access. Aliases take up very 

little disk space, and can be really useful short-cuts. If you wanted to, 

you could create several aliases for a document you used often, and 

keep them in different places. 

The Apple menu 
There is one very good place to put aliases, and that's in the Apple 

menu. We haven't looked at this properly yet, but it's a very important 

menu which is visible all the time - not just on the Desktop, but while 

you're working with other applications too. 

The Apple menu is where you'll find the Mac's Calculator, 

Notepad, Scrapbook and other built-in utilities. But you can also add 

your own items to it - like aliases. To add an alias to the Apple menu, 

you'll need to first create the alias and then drag it to the Apple menu 

items folder in your System folder. The alias will be on the Apple 

menu next time you look. 

If you have System 7.5, there is a much quicker method. First 

select the item you want to make the alias of, then choose Automated 

Tasks from the Apple menu. From the sub-menu that appears 
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The Apple menu 

alongside, choose Add Alias to Apple Menu. (Don't worry if your 

Apple menu looks nothing like mine - I've adapted mine for my own 

needs.) 

File Edit View Label Special 

About This Macintosh... 

J Adobe Photoshop!!3.0 alias 

jig Adobe® PageMaker® 6.0 

g§ AppleCD Audio Player 

\ Automated Tasks 

U Calculator 

®Ci« 

ClarisUJorks 

(•£) Control Panels 

^ DiskDoubler!!App3.7 

g EUEAYTHING! 

QFAH In 

Fau^tatiic 

Add Alias to Apple Menu K 

Find Original from Alias 

Share a Folder 

Share a Folder (no Guest) 

Start File Sharing 

Stop File Sharing 

Turn Sound Off 

Turn Sound On 

Your Mac will automatically create the alias and put it in the 

Apple menu items folder. It takes a few seconds, but once the process 

is finished you'll find the alias in the Apple menu. 

Adding things to the Apple menu 
__ You can drag anything into the Apple menu items folder, 

1 including both applications and documents. But it's best 

Apple Menu items uge rather that the items themselves, because 

that leaves you free to organise the originals properly, rather than 

cramming everything into the Apple Menu Items folder. 

Aliases aren't the only things you can add to your Apple Menu. 

The release of System 7.5 has added a very interesting new feature. If 

you add a folder (preferably, an alias of the folder) to the Apple menu, 

when you select it from the menu, it displays a sub-menu listing all the 

contents of that folder. And if that folder contains other folders, an 

arrow appears alongside them. Move the mouse pointer to select 

those, and their contents appear in turn... in fact you can delve up to 

five folders deep using this method (although you can nest folders as 

many layers deep as you like on the hard disk). 
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I keep all my work files in a single folder called (imaginatively) 

EVERYTHING! By putting an alias of this folder in my Apple menu I 

can work through to individual files via the publication I'm working 

on, through live versus finished work and the specific project folders. 

Expert tips 
• You can keep more windows open by using WindowShade (System 

7.5). This control panel lets you shrink open windows to just their 

title bar by double-clicking on the title bar (or using any other 

keyboard/mouse combination you specify in the control panel). 

Simply repeat the operation to expand the window again. 

• The extended Find... dialog you get with System 7.5 is worth 

exploring. You can specify file sizes, labels, creators, creation dates 

and other characteristics to perform some pretty sophisticated 

searches. It might not save you much time on a single Mac, but it 

could make searching a server a lot, lot faster. 

• If you like icons but you also like the neatly sorted information in 

list views, go to the Views control panel (see also chapter five) and 

click the largest icon size in the List Views area. 
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5: Control 
Panels 
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You use the Macintosh's control panels to set your machine up 

the way you want, and to configure some of the software that 

comes with your machine. You may not have all of the control 

panels mentioned in this chapter, depending on the age of your 

machine, and you may have additional control panels to go with 

software you've installed. At any rate, these are the control panels you 

are most JLikely to see. 

There are three ways to access the control panels: 

1. Choose Control Panels from the Apple menu (you can do this from 

within any application, don't forget). If you have System 7.5 you 

can choose the one you want from the list that appears in the sub¬ 

menu. 

2. If you have an earlier version of the System, choosing this option 

won't display a sub-menu, but will return you to the Finder and 

open the Control Panels window. 

3. You can open control panels directly by first opening your System 

Folder, then finding and opening the Control Panels folder. 

The control panels shown in this illustration won't necessarily 

match those on your machine because I've installed many 

applications, some of which come with control panels of their own. 
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Control panels 

But each Mac owner has a certain 'core' set of control panels. These are 

some of the more useful control panels supplied with System 7.5. 

Earlier versions of the System will have most but not all of these 

control panels, and some of the options may have moved from one 

control panel to another. 

Some of the changes you can make in these control panels will 

only come into effect if you shut down and restart the machine - a 

small warning dialog will tell you if this is the case. 

Apple Menu Options 
Earlier on we saw how adding a 

folder (or its alias) to the Apple 

menu let you view deeper layers 

of folders via sub-menus. Here's 

where you switch this feature on 

or off. The Apple menu also lists 

your most recently-used files 

and applications - you can use 

the lower part of this control 

panel to choose how far back it 

'remembers'. (The Servers option 

is for more advanced use.) 

ATM (Adobe Type Manager) 

iJ btm" v 383 

AdobeType Manager 

Ooff f Personalize ATM... j 

ATM is Active 

Font Cache Preserve 

<§) Line spacing 

O Character shapes 

© 1983-1995 Adobe Systems Incorporated. 

ATI Rights Reserved. U.S. Patent Numbers: 
5,233,336; 5,255,357; and 5,185,818. 

Adobe Type Manager is supplied as 

part of System 7.5. Previously, it had 

to be bought separately, although 

many Macintosh applications were 

(and still are) supplied with it. 

Including it is Apple's concession to 

the ubiquity of PostScript fonts (see 

the System chapter for an explanation 

of fonts), despite the fact they would 

dearly love everyone to use their own 

TrueType font format. ATM helps 

fonts display and print properly. 
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Colour 

Window colour: I MM Stanrlnrrl 

This control panel lets you 

choose the highlight colour. 

When you select text in a 

word processing 

document, for example, it 

will bfe shown against a 

solid colour to indicate it's 

highlighted. If you want a different colour to the standard black 

highlight, choose it here. The lower part of the control panel lets you 

change the coloured border of your windows. The standard colour is 

blue, but you can choose from a whole range via the pop-up menu. 

Highlight colour: | WM Black & White !! 

* 

Z) 

Date & Time 
Date 0 Time 

Current date (T) Current time 

| 7/11/95 | 3:14:46 pm | 

[ Oate Formats... ] [ Time Formats... ) 

^ Time Zone 

London is » o«v in th« 
curront tim* zone. 

£3 British Summer Time 

3654] Menubar Clock 

O On ®Off 

* 

[ Set Time Zone... ] | Clock Options... ] 

Your Mac has a built-in clock. 

Should you ever need to reset 

the time, this is the control 

panel you use. You can also 

switch the menu bar clock on 

and off from here, as well as 

cater for your own specific time 

zone and even British Summer 

Time. 

Desktop Patterns 
-Q-- Desktop Patterns 

[ Set Desktop Pattern ] 

You're not stuck with the plain grey 

Desktop pattern that your Mac arrives 

with. Using this control panel you can 

choose one of 64 colourful designs to 

brighten up your machine. You use the 

scroll bar/scroll arrows to cycle through 

the choices, and the window above the 

scroll bar shows what the pattern looks 

like. Click on the Set Desktop Pattern 

button once you've made your choice. 
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Extensions Manager 

Extensions Manager 

Extensions Manager I 

Sets: 3 

Use this control panel to turn 

off problematic extensions so 

you will be able to boot your 

Macintosh correctly. 

Warning: Incorrect use of 

this control panel may cause 

problems with your Macintosh. 

[ Undo ) 

[ Help j 

Extensions 

Conflict Extension1*1 

!!Now Toolbox y 
A/ROSE 

I 
!!Acrobat1*1 PDFWriter 

!!Apple CD-ROM 

!!Apple Guide 

!!AppleScript1*1 ' 

!!AppleShare 

!!At Ease 7.5 Layer Patch . 
!!At Ease Startup * 

Camer aMan1*1 Extension 

Claris Organizer Alarms 

!!Colour Picker 

!!Colour SW Pro 

!!Dragging Enabler 

FaceSpan Extension 

!!FaxMonitor 

!!FaxPrint 

!!File Sharing Extension $ 

You'll find out 

more about 

Extensions in 

the chapter on 

the System, 

next. Extensions 

Manager is a 

control panel 

that lets you 

prepare 'sets' of 

System 

extensions that 

load up when 

you start your 

Macintosh. 

General controls 

: General Controls \ 

Insertion Point Blinking - 

^ Show Desktop when in background 

[~1 Show Launcher st system startup 

u 
Shut Down Warning - 

] Warn me if computer was shut down improperly 

- Folder Protection - 

!!Protect System Folder 

f~| Protect Applications folder 

When opening or saving a document, take me t< 

O Folder which contains the application. 

<§) Last folder used in the application. 

O Documents folder. 

There are many options here which can make a lot of difference to 

your Mac. When you're working in an application, your Mac's 
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Desktop, including your hard disk and wastebasket icons - and any 

others you've left out - is visible in the background. If you don't want 

to see this extra clutter, click the Show Desktop when in background 

option off. 

Below this is an option for showing the Launcher on startup. You 

may already have seen the Launcher. It's Apple's latest idea for 

making the Mac easy to use. It's a Desktop window containing buttons 

which launch your favourite applications with a single click. It's not to 

everyone's taste, so here's where you can switch it off. 

Below this is an option for warning you if your Mac was shut 

down 'improperly'. You always need to use the Shut Down option 

when you switch off, and if you have small children or inexperienced 

users using your Macintosh, you might want to leave this feature on 

because it gives them a gentle reproach when they restart the machine 

after an 'incorrect' shut-down. Otherwise, switch it off. 

In the bottom left are two options for folder protection. If you click 

these on it means that no-one can make any changes to your System 

folder and the special Applications folder set aside in System 7.5 for all 

your programs. If other people are using your Macintosh, or you're 

worried about doing some damage accidentally, click these on. 

Otherwise, leave them off. 

To the top right you'll see options for changing the blinking speed 

of the cursor when you're editing text, and the number of times a 

menu flashes when you make a selection. The first choice is purely 

cosmetic, but if you want your Mac to be appreciably quicker to use, 

you'll turn off menu blinking altogether. 

Lastly, in the bottom right-hand comer, you'll see a series of 

options for storing files. When you save a file, you are always given 

the chance of finding exactly the folder you want to save it in. 

However, it saves a bit of effort if the right folder comes up 

automatically. You can get half way there by choosing the right option 

here. By default you are offered either the folder than contains the 

application you're using, the last folder you saved anything in with 

that application or the Documents folder (part of System 7.5, and the 

'twin' of the applications folder). It all depends on how you work, but 

for my money the middle option is by far the most useful. 
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Keyboard 

Keyboard 
mmmm KeuhoMaWmmmm 

Keg Repeat Rate 

ooo®o 
Slow Fast 

Delay Until Repeat 

o o<g>oo 
Off long Short 

|—| Use Cemmand-Optton-Space bar to rotate 
L-1 through keyboard layouts. 

Until Repeat (how long you 

they start repeating). 

The Americans (bless 'em) have a slighly 

different keyboard layout to us Brits (as 

do many other countries). If you want to 

make sure that your pound signs come 

out as pounds (and not hash symbols), 

choose the British option here. The only 

other things to set are the Key Repeat 

Rate (how fast letters appear if you hold 

down one of the keys) and the Delay 

have to wait after pressing a key before 

Labels 

!!Labels 

\Wm\ 1 Essential 

\mm) |Hot_1 

HI 
Cool | 

!!![ Personal 

\mm\ Project 1 

M Project 2 

Earlier on we saw how you could use labels to 

categorise and organise your documents. This 

control panel lets you change the standard 

label names. Just drag the mouse'pointer over 

the text and start typing to change it. You can 

also change the label colours - simply click on 

a colour and up pops a big 'colour wheel' 

which you can use to pick a shade. 

Map 

mmmmmm Map 

[add City] [Bemoue City] v 

| London If Find ]| 

Latitude 40 * 43 ' g|N 

Longitude 74 0 1 ' DE * 

Time Zone 5 h 0 mQ + 

mi 3460 9:47 am [ Set ) 

This is an excellent control panel 

which is almost like a miniature 

application. It displays a map of the 

world and stores a list of major cities 

and their locations. Once you've 

chosen your 'home' city you can use it 

to find the time anywhere else in the 

world. You can also add and remove 

cities from the list. An excellent but 

often overlooked tool. 
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Memory 
If your Mac is a little short of RAM (and most of us could use more) 

you'll be making fairly frequent trips tothis control panel. The first 

option. Disk Cache, can usually be left at the default setting - it's a 

segment of memory kept aside for storing frequenly used bits of 

programming code, and is handled automatically by your Mac. The 

next option. Modem Memory Manager, is for users of later Macintosh 

models having trouble running older software. Sometimes, switching 

this option off can help troublesome software run - otherwise, leave it 

on. Virtual Memory is becoming increasingly significant. On any 

Macintosh with a 68030 processor or better, you can use virtual 

memory to supplement the machine's RAM. With virtual memory 

switched on, the Mac uses part of its hard disk as 'pretend' RAM. It 

does get you out of a hole if you don't have enough memory for a 

certain application (or for running several together), but it does slow 

the machine down. 

Memory \ 

Disk Cache 

Always On 
H || 

Modern Memory Manager 

(•) On 

Ooff 

Select Hard Disk: 

Virtual Memory 

(•) On 

OOff 

] Hard Disk 

Available on disk: 94M 

Available built-in memory : 8M 

O0u 

<§)0ff 

Percent of available memory 

to use for a RAM disk: 

095 5095 10095 

RAM Disk Size |0K | 

[ Use Defaults 
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Memory 

But here's a big tip for PowerMac owners. Because of quirks in this 

machine's operating system, applications designed specifically for the 

PowerMac often need less RAM if virtual memory is switched on (you 

only need to set aside as little as 1Mb virtual memory for this to work). 

Strange, but true. There is a speed penalty, but this is usually more 

than outweighed by the extra freedom it gives you. 

The last option, for creating a RAM disk, is when you don't have a 

shortage of RAM but you do have a shortage of speed. A RAM disk is 

a 'pretend' disk drive which is actually held entirely in the machine's 

RAM. Because transferring information in and out of RAM is 

dramatically faster than transferring it from disk, this will give you a 

speed boost. Bear in mind, though, that when you switch off your 

machine the contents of your RAM disk will be lost forever - so make 

sure you save them to a 'real' disk first! 

Finally, the Use Defaults button returns all the settings to the 

factory defaults - useful if you get everything hopelessly wrong, or 

you just want to start again from settings you know will work. 

Monitors 
This control panel changes the 

number of colours your screen 

displays. Some older programs 

insist you set your Mac to 

display only 16 colours, for 

example. You can get a bit of a 

speed boost by setting your 

display to reduced colours, or 

even black and white, but for 

the most part you can leave it 

set to display 256 colours or 

'Thousands' for the best 

quality. The rest of this control 

panel (the Options... and 

Identify buttons and the lower, 

main, window) are for people using more than one monitor - which is 

a pretty specialist area. 

Monitors I 

Settings of selected monitor: 

O Greys 

(§) Colours 

16 j> 
256^ 

<> 

Options... ) 

[ Identify ) 

Drag monitors and menubar to rearrange desktop. 

O Rearrange On Restart 

(§) Rearrange On Close 
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Mouse 

Mouse 

2 

Mouse Tracking 

j] 
o 000(8)00 

Very Slow Slow ^ Fast 

i 

* !!!!

!o *o 
Double-Click Speed 

Does your mouse pointer skate around too 

quickly? Do youind it hard to double-click 

quickly enough for it to register? You can 

control both of these options from this 

control panel. The Very Slow option for 

mouse tracking is useful if you're using a 

drawing program, while a slower double¬ 

click speed is often essential for beginners 

not yet fluent with the Mac mouse. 

Numbers 

rJ Numbers 

$3 Number Format: 1 British 

- Separators- 

Decimal: |~ |[~w] 

Thousands: [, |pw) 

r Currency —-( 

Symbol: B|[ 

(•) Before number : 

O Hfter number 

£ 1,234.56 

The British, like other 

nationalities, have their 

own chosen way of 

displaying numbers and 

currency. You can choose a 

national preference from 

the pop-up menu, top right, 

and add your own 

preferences using the other 

options. 

PC Exchange 
PC Exchange is a valuable 

addition to System 7.5, and 

much better than the old 

Apple File Exchange, which 

did the same job. It lets your 

Macintosh read PC disks, 

and via this control panel 

you can choose the Mac 

application that opens 

specific types of files that 

PCs generate. For more 

advanced users, this one. 

Each assignment below determines which 

Macintosh application program is used when 
you open DOS documents with a particular suffix. 

DOS Suffix Application Program Document Ti, 

£3 sICT 

( fldd..^ ) (Change... ) ( Remoue ] 

<§)0n QOff [ Options... ] 
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Sound 

Sound 
Your Mac emits a 

warning sound 

whenever you do 

something wrong, or 

try to do something 

impossible. In fact it 

has a small repertoire 

of noises to choose 

from, and you can 

control the volume 

they're played at. If 

you have access to 

other sound files, 

you can add them to the list. You can also use this control panel to 

record sounds of your own - all current Mac models have sound¬ 

recording hardware, and the 5200 and 5300 have microphones built 

into the monitor (you need an external microphone for other models). 

Views 
This control panel 

changes the way 

items appear in 

windows. The 

standard font 

(Geneva) is very 

legible at small 

sizes, and is the 

ideal choice for 

most users. If you 

find it ugly, though, 

you can change to 

another font via the 

pop-up menu and another size via the menu alongside. 

The Icons Views affect the way icons are arranged in folder 

windows. The Always snap to grid option will align them to a fixed 

Font for views: Geneua !a 
•Icon View*-'-- 

D D D D <§) straight grid 

D Q D Q O Staggered grid ^ 

O Always snap to grid 

® o o 
!!Calculate folder sizes 

r~l Show disk info in header 

0 Show size 

£3 Show kind 

[X] Show label 

R1 Show date 

I"! Show version 

f~l Show comments 

j Alert Sounds 

«») 

Quack 
Simple Beep 

Sosumi 

lilild Eep ^ 

filert Uolume [ Rdd... 

O 
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but invisible grid on the screen for extra neatness (although you can't 

pack icons together to make best use of the space). 

The List Views options control the size of icons displayed in 

windows when you view by name rather than icon, while the other 

options control how much information is displayed. 

Quick tip: to speed up the rate at which windows are opened when 

you double-click on their icons, switch Calculate folder sizes off. 

WindowShade 
WindowShade is a neat little 

feature that can keep your Desktop 

that much neater. If there are 

windows getting in the way - but 

you don't want to close them - 

simply double-click on the title bar 

to shrink them to just the title bar. 

You double-click again to expand 

them back to their previous size. You don't have to double-click - you 

can set other key/mouse combinations via this control panel. 

Expert tips 
• If you're on a network, open the Apple Menu Options control panel 

and type a number into the Servers field in the Remember recently 

used items area. This doesn't record the names of the servers you 

most recently used - it actually records the folders within those 

servers that you accessed. 

• How large a font cache should you set aside in the ATM control 

panel? Adobe recommend around 50K per font you use regularly, so 

if you use lots of fonts you'll have to make some tough choices 

between available memory and font-drawing speed (the font cache 

works on a first-in, first-out basis). 

• If you've got £50-60 to spare, get a Kensington Thinking Mouse. 

They feel and work ten times better than the standard model, and 

you can program their four buttons to offer amazing things, 

including speed-switching, programmable short-cuts and custom 

acceleration. 

mmwm UiindotuShade 

MMZ 

t 

-\~S~B 

—r*n- 
3 Clicks to hide or show window: 

o <•> o . 

3 Off 2 3 ‘ 

Also use modifier keys: 

!!IX 1 !!loptktt 1 !![CwtrotJ 

13 Make sounds when using WindowShade 
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The System is what makes your Mac a Mac. It's the software that 

handles files, folders, drives, menus, displays, dialogs and 

everything else that happens on your machine. And all the nuts 

and bolts are located in the System Folder on your hard disk. 

It's very dangerous for beginners to tamper with the System 

Folder (which is why System 7.5 lets you protect it via the General 

Controls control panel) but more experienced Mac users will find 

themselves working with it a lot. 

r And one of the easiest ways of grasping how the System 

1 Q 1 works is to take a tour through some of the items in the 
System Folder _ . , 

System Folder... 

Apple Menu Items 
- If you want an item to appear in your Apple menu, 

l & ] simply drag it (or an alias) into this folder. If you want to 

Apple Menu items out more about the Apple menu, turn back to 

chapter four. 

Clipboard 
Whenever you copy anything while you're working (a 

picture, or a piece of text, for example) it7s saved to this 

clipboard temporary Clipboard file. When you 'paste' what you've 

copied into a new document or new location, it7s the contents of the 

Clipboard you paste. The Clipboard stores the last thing you copied 

indefinitely - until you copy something new. 

Quick tip: you can see what's currently stored in the Clipboard file 

by choosing the Show Clipboard option from the Edit menu when 

you're in the Finder (i.e. back at the Desktop and not within an 

application). 

Control Panels 
- This is the folder where the control panels are stored (see 

chapter five for more on control panels). Control panels 

control Panels ^ parj Qf the operating system and they let you modify 

the way your Mac does things. As your Macintosh starts up, it loads 

control panels and System Extensions (which we'll look at shortly) as 
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part of the operating system before even the Desktop appears. Some 

applications install control panels of their own in addition to those that 

come as part of the Mac's operating system. That7s because these 

programs offer features that need to interact with the operating system 

at a very basic level. 

Quick tip: it's a big feature of System 7.5 that you can drag control 

panels. System Extensions and fonts (see the next two items) onto your 

System Folder icon, and the System will put them in the right place. 

Extensions 
^ Extensions are very similar to control panels, in that they 

lOi load up alongside the System software when you start up 

Extensions Macintosh. That's why they're called 'Extensions' - they 

extend the capabilities of the System software. Many Extensions are 

supplied with your Macintosh, and many more are installed when you 

install new applications. The real difference between Extensions and 

control panels is that Extensions don't have any settings for you to 

adjust. 

Note that both control panels and Extensions can cause 'conflicts'. 

It all depends on whether they have been programmed according to 

the 'rules' laid down by Apple's engineers and how many extra 

Extensions and control panels have been added to your System Folder. 

A conflict occurs when two Extensions/control panels 'fight7 for the 

same bit of memory, or other Macintosh resource. If this happens you 

need either the patience of a saint and a great deal of trial and error or 

a special piece of 'conflict catching' software to track down the 

problem. Problems usually occur while your Mac is trying to start up, 

but can occur during normal use. 

Quick tip: if you hold down the Shift key as you start your 

Macintosh up, the System will load without any Extensions or control 

panels (a message will appear on the screen to confirm this). If your 

Mac now starts successfully, it's a sure-fire certainty that you've got an 

Extensions/control panels problem. 

Extensions and control panels also eat up valuable memory, and 

you often don't need them all running at once. System 7.5 has a 

control panel (how ironic) called Extensions Manager which lets you 
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choose sets of Extensions and control panels to load up. You could 

have one set for word processing, one for games, one for accounts and 

so on. 

Finder 
__ The Finder is the application that runs all the time in the 

l! -1 background, handling the Desktop display and sorting out your 

Finder fjfles an(j folders. Do not rename this file, delete it or move it out 

of the System Folder. It's a crucial part of the System and your Mac 

can't work without it. You may see other files with the same icon in 

your System Folder called System Enabler or System Update. Don't 

touch these either. As their name suggests, they are updates and 

modifications to your basic Finder application and work alongside it. 

Fonts 
Fonts are the different typefaces you see on your screen, and 

Ivi 1 which you can choose from in word processing documents and 

Fonts other Macintosh applications. The font used for the menu bar 

is called Chicago and the font you see in windows is Geneva. Fonts are 

stored as files in the System Folder, and your Mac is supplied with half 

a dozen or more. You can get hold of fonts from a variety of places, 

and installing them is easy with System 7.5 - you just drag the font 

files on to the System Folder icon and your Mac sorts out the rest. 

A font can be set to any size you like, and can be made italic or 

bold, underlined or turned into an outline and more. This was one of 

the factors in the early success of the Macintosh - the way it could 

display and print fonts. 

Fonts are slightly tricky in that there are different types. These 

have come about because your Mac has to be able to both display 

fonts on the screen and to print them smoothly. The traditional 

solution has been to provide fonts as a 'pair' of files - a 'screen' font to 

look after the screen display, and a 'printer font' to provide the much 

smoother output you need on paper. 

Because the Mac's display is made up of dots, screen fonts too are 

made up of dots. In the past, you had to have a screen font file for 

every size you wanted to display on the screen. Happily, that7s now 
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been sorted out by both Adobe Type Manager and, even more neatly, 

by the TrueType font format. 

By contrast, printer fonts are made up of geometric shapes. This1 

means that your Mac can instruct the printer to print them at any size 

and they will still come out with smooth outlines. 

Having to keep pairs of font files has always been a nuisance. 

Adobe, the American company that practically invented Desktop 

publishing technology, provide an excellent tool in the form of Adobe 

Type Manager (see the control panels chapter). This software uses the 

printer font to draw the screen image. You still need a screen font file, 

but you don't need one for each type size and the screen 

representation of fonts is much smoother and more faithful. 

Indeed, this is the system now used by the publishing industry 

(which is almost exclusively Macintosh-based in this day and age). 

Adobe's PostScript printing system, universally used for producing 

professional publications electronically, uses 'PostScript fonts'. This 

means having a single screen font, and single printer font and Adobe 

Type Manager (supplied with System 7.5 but available from a variety 

of sources - often with commercial applications - for owners of earlier 

Systems). 

In System 7.5, both screen fonts and printer fonts are stored in the 

Fonts folder. In earlier Systems, printer fonts were stored in the 

Extensions folder and screen fonts formed part of the System file. 

Having to cope with two font files is still a bit of a nuisance, 

though, and it can cause problems if they get separated, or one gets 

lost, or one is replaced and the pair doesn't match any more. 

This is one of the reasons why Apple invented the competing 

TrueType font format. TrueType fonts are single font files that handle 

both the screen display and printed output. They use a little more 

memory, but they are much more convenient, and the fonts supplied 

with newer Macintoshes are in TrueType format. 

However, the publishing industry still revolves around PostScript 

fonts, so Apple is in the strange position of having to support both 

TrueType fonts (by including them with the machine) and PostScript 

fonts (by now supplying Adobe Type Manager as part of the System 

software). 
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Just to make things even more complicated, Apple have released a 

competitor to PostScript called QuickDraw GX. It aims to integrate the 

same kind of printing features and quality of PostScript with the 

Macintosh operating system and the applications that run on it. 

To find out more about QuickDraw GX, see the chapter on Apple 

Extras. For now, though, don't give it too much thought. For the time 

being, QuickDraw GX has made little headway, and it's still at the 

stage of being a curiosity. It also gobbles up lots of precious memory if 

you install it as part of your System. 

Note Pad file 
p!!The Note Pad, like the Scrapbook, is a standard Mac utility. 

t 1 It lets you jot down notes while you work, and this is the 

Note Pad File ^je wjiere yQur notes are stored. Again, you can double¬ 

click on it if you want to see the Note Pad (which is on the Apple 

menu anyway). 

Preferences 
Most Macintosh applications need to store information 

IS-1 about how they've been configured or how individual users 

preferences ^ave customised them. They do this by creating small 

'preferences' files. In previous versions of the System they would turn 

up all over the place - usually, loose in the System Folder. In System 

7.5 they are grouped together in this Preferences folder. 

It's a good idea to periodically sift through your Macintosh's hard 

disk, weeding out old and unwanted files. Outdated preferences files 

for applications you've long-since discarded are prime candidates for 

the wastebasket. 

PrintMonitor Documents 
If your Mac is printing something, you don't have 

to sit quietly and wait until it's finished before you 

start working again. When you set up your printer 

you have the option of switching background printing' on. When 

background printing is on, you can carry on working on your 

Macintosh while it's feeding data to the printer. 

PrintMonitor Documents 
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PrintMonitor Documents 

The only drawback is a jerky mouse and sluggish response. There 

seems no way round'this, and it afflicts even the fastest Macintosh 

models. Still, it's better to be able to work jerkily than not at all. 

Scrapbook file 
__j The Scrapbook is one of the Mac's handy little utilities - it 

fftl lets you store any number of pictures in a kind of scrolling 

scrapbook File gajjery window (see the chapter on Mac gadgets for 

more). This is the file that contains all the images. Double-click on it if 

you want to see the Scrapbook. 

Startup Items 
If there are applications you use constantly, you can save 

1 (D 1 yourself time and effort by putting them, or a file you use 

startup items ^ ^ tjme/ or an aijas Gf either, into the Startup Items 

folder. For example, if you have a Mac with a CD-ROM drive and like 

a little music while you work, you can put an alias of the System 7.5's 

audio CD player into this folder. Then, when your Mac has started up, 

you can put a CD in straight away. More importantly, if you use 

personal organiser software, you can put your diary file in the Startup 

Items folder and leave the application running all day in the 

background, ready for when you need to refer to it. 

Shutdown items 
__ This works in exactly the same way as the Startup Items 

I d)l folder except that it waits until you shut down your Mac 

shutdown items be£ore activates the contents. It could be useful if you 

need to remind yourself to update tomorrow's to-do list before you 

finish work - just put your to-do list file in here and it will be opened 

automatically when you attempt to shut down your Mac. 

System 
n In older versions of the System, this file contained the bulk of 

[151 the Mac's operating system. With later versions of the System, 

system ^ relevant files are split up into different folders within the 

System Folder. The System file still contains the basic Mac sounds. 
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though, plus the various keyboard layouts for different countries (as 

described in the control panels chapter). 

The System file is actually a special kind of document called a 

'suitcase'. You can recognise suitcases by their distinctive icon. In the 

old days suitcases were used much more, but now, the only other time 

you'll see suitcases is in the Fonts folder, where they're used to store 

screen fonts and TrueType fonts. 

Suitcases are a lot like folders, in that you can double-click on 

them to open them up, and you can drag items from one suitcase to 

another (only certain sorts of file can go into suitcases, though). 

Expert tips 
• The Finder and the System are usually updated in pairs. However, 

you may need to check the version numbers of both if you have a 

compatibility problem. 

• Let's face it, that 'Welcome to Macintosh' box you see during startup 

does get faintly tedious when you've already seen it fifty billion 

times before. But you can create your own startup screen if you have 

an application that can save in StartupScreen format (the excellent 

shareware GraphicConverter, for example): just create a file called 

'StartupScreen' and drag it into your System Folder. (In Photoshop, 

save it out as a PICT Resource.) 

• Unless you're working on documents for publication, stick to 

TrueType fonts. Not only does it make your System folder less 

cluttered, it saves you RAM too. Oh yes it does! Although TrueType 

fonts use more memory than PostScript versions, you can switch 

ATM off, and that's the biggest memory hog of all. 

• System 7.5's Note Pad is much better than the previous version. You 

still only get eight pages, but they expand to full screen size and 

they have scroll bars so that you can write a lot more. Why not 

maintain a to-do list using Note Pad, and put an alias of Note Pad in 

both your Startup Items and Shutdown Items folders? Every 

morning you'll be reminded of what needs doing, and every night 

you'll be reminded to plan tomorrow's work. It works for me! (In as 

much as anything does...) 
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There are a number of options on the Apple menu that lead to 

built-in accessories and a couple of more important Macintosh 

controls. Here's a guided tour: 

About this Macintosh... 

About This Macintosh 

*na System SoftwareB1 -7.5.1 

Power Mactitnsh © Apple Computer, Inc. 1983... 

Built-in Memory : 8,192K Largest Unused Block: 6,403K 

Total Memory: 16,464K 16,464K used as RAM on Hard Disk 

QuarkXPress!! 6,000K !!!_I 

£3 System Software 3,748K 

<> 

m 

This is the first option you see on the Apple menu if you are at the 

Desktop, and this is the dialog that appears if you select it. It tells you 

what type of Macintosh you have, which version of the System 

software you're using, how much memory is built in and how much 

memory you have in total (which includes any virtual memory you 

may have set up). To the right is a very important figure: Largest 

Unused Block. We'll come back to this shortly. 

In the bottom part of the window you'll see a list of all the 

applications currently running, and the amount of memory they are 

consuming. The System is always running, and basically gobbles up as 

much memory as it needs to, depending on how many fonts you have, 

how many Extensions and control panels are installed and other techie 

details like that. 

Other applications, though, don't take as much memory as they 

need at any one time. Instead, you have to choose the amount of 

memory to allocate to them. From the illustration above, we can see 

that of the 6,000K (6Mb) I've allocated to QuarkXPress, it's currently 

using only about 10-15%. Earlier on we looked at Info windows. Let's 

look at the Info window for the QuarkXPress application file 

(remember, you do this by activating the Finder, then selecting the file 

you want, then choosing Get Info from the File menu - or using the 

keyboard shortcut command-I): 
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About this Macintosh... 

This window gives us a lot of 

information about the 

QuarkXPress application, but the 

part we're interested in is down at 

the bottom in the Memory 

Requirements segment. The top 

figure. Suggested size, is set by 

the manufacturer and is a good 

guideline to the minimum 

amount of memory you can 

practically allocate to the 

application. The next figure, 

Mimimum size, is set by you. If 

you already have several 

applications running when you 

try to launch an application, you 

may not have much memory left. 

If you have less left than the minimum size you specify here, the 

application won't attempt to load. You can sometimes get away with 

specifying a minimum lower than the manufacturer's suggested size, 

but frankly it's not worth it. The Preferred size is the amount of 

memory the application will take for itself when you launch it, 

providing that amount Of memory is available. To go back to the 

About this Macintosh window illustrated on page 70, we can see that I 

launched XPress when there was more than 6,000K of memory 

available, so it reserved its entire quota. If there had been, less than 

6,000K available, but more than the minimum, it would simply have 

taken what it could. 

So why set a high 'preferred' figure and risk leaving valuable 

memory unused? As your documents get bigger and more complex (as 

you work on them, basically), so the application's memory 

requirements get bigger and bigger. By setting a large 'preferred' size 

you avoid the risk of the application running out of memory. If it does, 

nothing really bad happens, it just means it has to start shuffling data 

to and from the hard disk, instead of being able to keep it all in 

memory at once. 

I QuarkXPress" 

QuarkXPress!!

QuarkXPress!!3.31 

Kind: application program 

Size: 3.7 MB on disk (3,889,785 bytes 

used) 

Vhere: Hard Disk: Applications: 

Created: Tue, Sep 6, 1994, 10:50 am 

Modified: Fri, Nov 3, 1995, 9:47 am 

Version: 3.31 ©1986-1994 Quark, Inc. 

Memory Requirements 

Suggested size: 1600 K 

Minimum size: 1600 Ik 

!!Locked Preferred size: 6000 ! k 

Mote: Memory requirements will increase by 

2,691 K if virtual memory is turned off in 

the Memory control panel. 
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Incidentally, note the remark right at the bottom of the Info 

window. Remember how I mentioned earlier that a quirk in the 

PowerMac design meant that virtual memory actually reduced 

application memory requirements? Here's the proof! 

Lastly, let's get back to the figure at the top of the About This 

Macintosh window - Largest Unused Block. When applications take 

over a segment of memory, it has to be in a single block. When you 

quite an application, the remaining applications still running don't 

shuffle up to take up the space - as a result, you get smaller, irregular 

chunks of memory becoming available, not larger, single chunks. Take 

a look at this simplified diagram: 

Available memory 

QuarkXPress (6.000K) Largest unused block (12.000K 

Available memory 

Free memory left behint QuarkXPress (6.000K) Largest unused block 
by quitted application (6.000K) 

In the top example, XPress was the first application to be 

launched, and it has taken 6,000K to leave 12,000K free out of a total of 

18,000K. In the second example, though, XPress was launched while 

another application, itself taking up 6,000K, was still running. When 

you quit that application, and free up its 6,000K of memory, it's split 

up from the rest, so that even though there's T2,OOOK of memory free, 

the largest single block is only 6,000K. 

This is called 'memory fragmentation'. If an application tells you 

there isn't enough memory when you try to launch it - and you know 

darned well there is - it could be because your memory has become 

fragmented. Quit all the applications currently running, then launch 
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About this Macintosh... 

them all again and you will find that the remaining memory is now in 

a single block. 

Incidentally, you can get hard disk fragmentation too, but this is 

less of a problem and you seldom need to worry about it (unless 

you're in the habit of keeping your hard disk 99% full). 

That just about covers the About this Macintosh... option on the 

Apple menu. But note that this option changes if you access the Apple 

menu while you're within an application. Instead, it reads about 

Claris Works... (or whatever the application you're running). When 

you choose this option it will bring up a title or info screen created by 

the software publisher: 

AppleCD Audio Player 
This is an excellent toy given 

away with System 7.5 and 

CD-ROM-equipped Macs. It 

offers all the controls of a hi- 

fi CD player, including 

shuffle, program, repeat and 

fast forware/reverse modes. 

You program tracks by 

dragging from the track list 

into the playlist. There are 

numerous options for 

customising the display, too. 
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Automated Tasks 
&B Automated Tasks | Rbout Automated Tasks 

§ Calculator 

[tgjCiK 

U Clarislliorks 

02 Control Panels !!

DiskDoubler!!App3.7 

§j EUERVTHING! !!

03 FAR In !!

Add Alias.to Apple Menu 

Find Original from Alias 

Share a Folder 

Share a Folder (no Guest) 

Start File Sharing 

Stop File Sharing 

Turn Sound Off 

Turn Sound On 

One of the major additions to System 7.5 is the AppleScript 

programming language (it's been available for some time, but only as 

an extra). Apple are keen for Mac users and Mac software developers 

to use AppleScript, so they've included some sample automated tasks 

to demonstrate its abilities. The most useful (I think) is the Add Alias 

to Apple Menu script. 

(A 'script7 is a cross between a program and a list of actions that 

you could carry out yourself, but you're getting your Mac to do it for 

you instead.) 

You can find out more about the AppleScript language in the 

'Apple Extras' chapter. 

Calculator 

r."i 
000 
CDGDCD 
[DCDIaI 

2 

+ 

OtDCD 
= fpa 

Oh, and another tip - 

(and keypad) instead 

The Macintosh calculator has survived 

unchanged for practically a decade. Sadly. It 

offers only the basic arithmetic functions, no 

memory, no specialist trigonometrical, 

mathematical, financial or scientific functions 

and no fancy design. But it's useful now and 

again, nonetheless. Quick tip: when you've 

finished your calculation, select Copy from the 

Edit menu, and the result is copied to the 

clipboard, ready to be pasted into a letter, a 

spreadsheet or whatever else you're working on. 

you can use the number keys on the keyboard 

of trying to click on the buttons with the mouse. 
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Key Caps 

Key Caps 

Key Caps 
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Are you having trouble finding the right character on the keyboard? 

This happens often if you're trying to find the right symbol from the 

Dingbats font (in the illustrated example above). Select Key Caps from 

the Apple menu and you see this window. Choose the font you want 

to examine from the Key Caps menu and then press the shift, 

command and option keys individually or in combination until you've 

seen all the characters that font can produce. (You can cut and paste 

characters from the sample window into your documents.) 

Note Pad 
!HI Note Pad 1 

Rounding up or down 

• absolute values 

Trigonometry 

• acos 

Statistics 

• mean 

Boolean logic 

• Choosing values 

• True or false 

Concatenation 

Counting 

Date conversions! 

P 

New and improved for System 7.5, 

Note Pad is a very simple word 

processor which lets you jot down 

ideas and notes as they occur to 

you. There are 8 pages to write on 

(you can erase text too, of course) 

and in the latest version you can 

enlarge the size of the pages by 

dragging on the resize box, bottom 

right-hand comer or clicking on 

the expand box, top right, which 

will expand the pages to full-screen 

size. 
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Scrapbook 

The old Scrapbook was a place where you could store pictures, either 

for transporting them from one document to another, or just because 

you like them. The new version stores pictures, text and sounds, and 

you can resize it to fill the whole screen if you like. 

Stickies 
3 Stickies are the electronic equivalent of those 

Don't forget to sticky yellow labels people stick to your monitor 

phone home... screen when you're not at your desk. You can 

change their font, type size, colour and window 

size, and have them loading automatically on 

start-up so that they're always there to remind 

you of the things you haven't done (a bit like being married, really). 

Expert tip 
• You can find dramatically superior versions of the Clipboard, 

Scrapbook and Note Pad in the public domain/shareware market. 
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System 7.5 owners have got lots to explore on their machines. As 

well as enhancements to the System itself and improvements to 

its various accessories (see the last chapter). System 7.5 also 

comes with the following add-ons which you can use or install as you 

wish: 

Apple Backup 

What would you do if your Macintosh's hard disk broke? Given that it 

contains probably all the things you've ever done with your Macintosh 

since you bought it, a spell in a psychiatric hospital followed by 

intense counselling is the most likely outcome. But you can safeguard 

against losing your precious data with this application. It lets you copy 

the entire contents of your hard disk on to floppy disks, or just the 

contents of the System Folder (sometimes, all that's gone wrong with 

your hard disk is that the System information has become damaged in 

some way and simply needs replacing). 

Apple Backup can do either of these things but - unfortunately - 

no more. Backing up my hard disk, for example, would take 284 

floppy disks and 174 minutes! Which means that it's hardly going to 

prove a feasible weekly safety measure. Backing up your hard disk is a 

chore at the best of times... 

Instead of using Apple Backup, look out for back-up applications 

from third-party suppliers. These can do all manner of useful things - 

the most useful of which is 'incremental backups' - once you've made 

your first, full back-up, the following backups only back up the things 

which have changed since last time. This method is much quicker, and 

much more efficient. 

78 From the makers of Macformat 

AppleScript 

AppleScript 
We met 

AppleScript in 

the last chapter 

when we took a 

look at the 

sample 

automated tasks 

available from 

the Apple 

menu. 

AppleScript is 

supplied with 

System 7.5, and 

you'd be wise 

not to remove it 

because many 

applications now depend on it to run. In the AppleScript folder, you'll 

find some more sample scripts, the AppleScript editor (shown) where 

scripts can be created and edited, and a two-part guide to what 

AppleScript is and how you use it. Don't expect to be able to leap 

straight in and start scripting - this is strictly programmers' territory. 

Quick tip: you can create your own scripts the easy way, though. 

The Finder in System 7.5 is 'recordable'. This means that if you start 

the Script Editor 'recording' then go back to the Finder and carry out a 

sequence of actions, the Script Editor will record these as an 

AppleScript script, which you can then save and use again. Be careful, 

though - don't inadvertently create and distribute a script that empties 

all your files into the wastebasket... 

Add Alias to Apple Menu 

tvr Description: 

Add Alias to Apple Menu - This script 

creates aliases to items and places them in 

the "Apple Menu Items" folder. The items 

“’cord Ttop \ Check Syntax 

tell application "Finder" 

set the Li at to selection 

if (count items in theList) = 1 then 

if class of item 1 of theList is applicatij| 

if name of (info for (theList os ali f 
set theList to {} 

Apple Video Player 
^ Some new Macintosh models are sold with video cards 

- you can display and record TV and video in windows 

Appte video puyer on yGur screen. This is the program that displays the 

TV/video. (If your Mac doesn't have a TV card, you might still be able 

to buy one separately.) 
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At Ease 

Tucked away this comer of your hard disk is a completely different 

interface for your Macintosh, one that hardly ever gets a mention in 

the Macintosh press or in books. 

The Macintosh is by far the easiest machine for beginners to 

master (and that includes PCs equipped with Windows 95), but it's 

still tough for absolute beginners. The screen is covered with icons, 

you have to do strange things with the mouse and you're terrified 

you're going to wreck things. 

At Ease is a replacement interface that consists solely of big 

colourful buttons you can click on to do the things you want. It's ideal 

for parents who want to make their Mac foolproof for the kids, or for 

those teaching someone else how to use a Mac for the first time. 

When you set At Ease up you can choose which applications, files 

and folders are available and you can use passwords and other 

security measures to prevent users straying, accidentally or otherwise, 

into the Finder, where they might trash valuable data. 

You can even set up many different 'users', each with their own 

user name and password and unique configuration of applications, 

files and so on. 

At Ease is much maligned amongst the 'serious' Mac fraternity, 

but it's an excellent way of helping beginners use your machine and of 

controlling access amongst a body of students, for example. 

From the makers of Macformat 

CloseView 

CloseView 

CloseUietn j 

ClQ§e 
View.,-,.! ®.if 

(§) Black on Lllhite 

Q lllhite on Black 

Keyboard (i) On 

Shortcuts QOff 

Magnification 

O On 
<§)0ff 

I—-1 ® ^ T 
i4Hiy 

= Option = Command j 

You'll find CloseView in 

the Special Needs folder. 

It's a control panel which, 

once installed, lets users 

with poor vision magnify 

the display by a chosen 

amount, view the screen 

white-on-black or black- 

on-white and use 

keyboard shortcuts to 

control the magnification. 

Easy Access 
The Easy Access 

control panel is also in 

the Special Needs 

folder. It's for people 

with physical 

disabilities and lets 

them configure various 

keyboard and mouse 

options to make using 

their Macintosh easier. 

Inexperienced users 

could find the Sticky 

Keys option useful - 

with this switched on, 

you don't need to hold 

down the shift, 

command or option keys when you have to type a complex keyboard 

combination (a tiny symbol at the far right of the menu bar shows you 

when you've pressed one of these 'modifier' keys). 

i t a c i I Q r r n r f 

53 Use On/Off audio feedback 

Mouse Keys: Oon ®off 

Initial Delay: 00®00 

long short 

Maximum Speed: OO ®000 

slow medium 
OO 
fast 

Slow Keys: ^ Oon (§)Off 

Acceptance Delay : O O <§) O O 

long short 

Use key click sound 

Sticky Keys: Oon <§)off 

53 Beep when modifier key is set 
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HyperCard Player 

HyperCard is an application that's been around almost as long as the 

Macintosh itself. They practically grew up together. Indeed, 

HyperCard has been given away with Macintoshes right from the 

start, usually in 'player' form. The HyperCard Player can show 

HyperCard documents ('stacks') that other people have created, but 

provides only limited tools for creating or editing your own stacks. 

HyperCard is a cross between a database and a programming 

language, but is a lot more fun that either of those two definitions 

make it sound. When it was first developed it had to do very complex 

things in a small amount of memory on slow machines - and it was a 

marvel. Now, the hardware has moved on, and HyperCard is showing 

its age, not helped by the multimedia add-ons that Apple continually 

bolt on to it in an effort to keep it up to date. 

Your main use for this HyperCard Player is likely to be for 

viewing stacks created by others - many companies or individuals 

distribute information, catalogues and indexes and HyperCard stacks. 

Newton Demo 
BIf you don't have one of Apple's clever little Newton hand¬ 

held computers/organisers, this demo will give you a taste 

Newton Demo wJia^ y0u're HUSSing. 
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Performa Extras 

Performa Extras 
IMS® 1 Performa Ewtras m& 

6 items 442.7 MB in disk 70.5 MB available 

HT 

PC 0 m 
DOS Compatibility Helpful Tips Performa Helpline 

1 1 o mf 

Sharing Your Computer Tutorial Part 1 Vhy Back Up <> 

~15 a 

Owners of Performa Macintoshes get several useful little help files and 

'tours' which explain how to use their computers and some of its more 

important features. These guides are now provided with System 7.5 in 

the Performa Extras folder. 

PowerTalk 

Phew. PowerTalk is a new-for-system-7.5 System Extension designed 

to make networking and communications dramatically simpler and 

straightforward. You can use it to handle voicemail, faxes, email from 

co-workers and more. It comes with 'catalogues' for storing contact 

details, and can be used to organise working groups amongst other 

things. You can also get 'gateways' so that your Mac and PowerTalk 
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can interface directly with the Internet and other on-line services. 

PowerTalk is a serious networking tool outside the scope of home 

users - it also takes up a big chunk of RAM once it's installed. 

If you want to find out more, though, take a look at the 

documentation files that come with the PowerTalk software in this 

folder - especially the animated tour (illustrated above). 

QuickDraw!!GX 

QuickDraw GX 
^sw-3 The first thing you need to know about QuickDraw GX is 

that if you install it your System will occupy about 8Mb of 

RAM (16Mb on a PowerMac). The second thing you need 

to know is that you need to take special precautions with your existing 

PostScript fonts to make sure it will be able to work with them 

subsequently. The third thing you need to know is that your printer 

may not yet have a QuickDraw GX driver (or your fax modem) and 

the fourth thing you need to know is that there are still relatively few 

applications which support the features offered by QuickDraw GX 

anyway. 

It had better be good. 

QuickDraw GX promises the following: 

• 'Intelligent' fonts with more control over tracking, kerning, font 

weights and a greater range of special characters. 

• Many new graphic effects (transparency, rotation, skewing and 

more). 

• Files can be saved in a new format (PDD) which other QuickDraw 

GX-owning Mac users can view even if they don't have the 

application that created them. 

• Improved printer sharing on networks. 

• You can print files by dragging them on to a desktop printer icon. 

• Files in a print queue can be more easily re-ordered. 

• It accepts extensions that allow printing effects like watermarks 

and multiple-page 'thumbnail' printing on single sheets (these two 

extensions can be found in the QuickDraw!!Extras folder). 

• You can mix page sizes in a single document. 
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QuickDraw GX 

It's hard to be convinced, not least because of the colossal RAM 

< wcrhead. (Will everyone really go out and buy another 4Mb of RAM 

nist to run QuickDraw GX?) 

And many of the 'enhancements' are to allow the Mac's in-built 

printing language (i.e. QuickDraw) to compete with Adobe's 

PostScript. Macs with QuickDraw GX will be able to get QuickDraw 

printers (the lower end of the market) to jump through hoops. But 

most serious Mac users have PostScript printers already (the price 

differential is diminishing), and professional Mac applications like 

QuarkXPress and Photoshop output in PostScript because iPs the 

standard format in the publishing industry. QuickDraw GX may be 

able to outshine PostScript in some areas, but PostScript is here, now, 

and supported by the whole Macintosh industry. (And doesn't need 

another 4Mb of RAM.) 

Expert tips 
• Apple's venerable HyperCard application has been given a new 

lease of life with AppleScript scripting support. Since version 2.2, 

programmers have been able to attach AppleScript scripts to 

1 lyperCard handlers - this dramatically improves HyperCard as a 

programming tool, and gives AppleScript scripts a decent front-end 

to work from. 

• If you want to do more with AppleScript, get the official 

AppleScript package from Apple. With it you get documentation 

(which is more precise than understandable, alas) and the FaceSpan 

interface application, which lets you create more complex and 

better-looking (easier to use, too) AppleScript applications. 

• If you fancy the idea of QuickDraw GX's universal document 

format, but don't fancy losing all that available RAM, take a look at 

Adobe's Acrobat software. This creates a PDF (Portable Document 

Format) file out of any Macintosh document, and anyone else with a 

copy of the Acrobat Reader (freely distributable) can read and print 

your documents without the original application. You can also add 

goodies like hypertext links, 'hot' tables of contents and pop-up 

annotations. 

• If QuickDraw GX catches on, Mac users will be able to create much 
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more complex documents without the expense of a PostScript 

printer. However, part of the expense of a PostScript printer is due 

to its internal processor, which takes a valuable workload from your 

Mac's own CPU when you print. And remember: all PostScript 

printers can print QuickDraw output, but QuickDraw printers can't 

cope with PostScript. 

• If you do have a PostScript printer, and you keep getting PostScript 

errors, the chances are you need more RAM in your printer. 

PostScript is singularly unhelpful in explaining why it's turned up 

its toes, but RAM is almost always the culprit. If you're printing 

DTP layouts, 2Mb might just cope with a single page. If you're 

printing several pages at a time, you'll need 4-6Mb minimum. 

• Still getting PostScript errors? Check the Chooser, to make sure 

you're using the right printer type, and check your software's Page 

Setup and Print dialogs to make sure the right printer driver is 

selected. It's easy to overlook. 
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The Macintosh System and Finder are already pretty simple to 

use, but there are certain little tips and wrinkles that can make it 

easier still. Here's a selection: 

How much hard disk space is there? 
If you want to make your windows that little bit smaller and cleaner, 

switch off the Show disk info in header option in the Views control 

panel. This does mean you don't know how much hard disk space is 

available, though... but switching to icon view tells you straight away. 

How big is that folder in the window? 
It's always useful to know how big folders are, but it takes your Mac 

precious moments to calculate the folder sizes when you open a 

window, and you can speed it up no end by switching off the 

Calculate folder sizes option in the Views control panel. After all, if 

you need to know how big a folder is, you can just select it and hit 

command-I to call up its Info window. 

Some applications let you create template 

files that you can use to create new 

documents, and which you can't 

accidentally overwrite. System 7 made this 

feature redundant with the Stationery pad 

option in a file's Info dialog (select the file, 

then hit command-I). Rather neatly, the 

file's icon is changed to reflect its new 

stationery status. 

Clever aliases 
Sb The more you play around with aliases, the more you 

HP reahs° how useful they are. For example, if you're 

mi***09regUiariy m0ving between two or more folders, keep an 

alias of the others in each. And if you like windows so big that they 

cover up the wastebasket, put an alias of it in the folder! 
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Aliases 

Aliases and networks 
Plodding through the Chooser to log on to another Mac or a server on 

your network can be a real chore. But once you've set up an alias for 

the machine or destination folder you regularly use, it's just a double¬ 

click away (and a user name/password dialog). 

Aliases as catalogs 
This one is really smart. If you keep lots of files on external floppies 

(poor soul) and you have the patience to create an alias of each file for 

storage in a folder on your hard disk (or another floppy), you can: 

1. Enjoy an alphabetical list of all your files. 

2. Find out which disk contains any one file by double-clicking on 

the alias (your Mac will obligingly tell you where the file is). 

Finding originals 
You've got an alias of a file, but you don't want to load the file, you 

just want to find it - what do you do? Hold down option when you 

double-click it! 

Unmounting external drives/disks 
There's an 'undocumented feature' in System 7 (fixed in 7.5) that stops 

you ejecting a SyQuest cart or CD-ROM while you've got File Sharing 

turned on. This happens when you're not even 'sharing' that disk. To 

get round it, find a copy of the Unmountlt utility. 

Recording Finder scripts 
System 7.5 owners are lucky in that they 

have AppleScript and a 'recordable' 

Finder. Locate the AppleScript Script 

Editor (probably in the AppleScript 

folder in your Apple Extras Folder), 

launch it, press the record button and 

then go b<>ck to the Finder to carry out a 

sequence of actions. When you've 
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finished, go back to the Script Editor, stop the recording and save the 

script as an application. For example, you could record a script that 

opened up half a dozen regularly-used windows and tiled them neatly 

on your Desktop - and you could put this script in your Startup Items 

folder if you wanted to be really cool. 

Don’t accept scripts from strangers! 
You can assume that commercial software publishers know 

(PC' what they're doing with AppleScript, but if a bungling 

workmate offers you a script and says 'run it', don't even think about it 

until you've examined it with the script editor. Using the script 

recorder, it7s easy to create an application that dumps everything on 

your hard disk... 

Silent running 
If you're sick of your Macintosh going 'boing' every time you do 

something stupid, go to the Sound control panel and drag the volume 

slider down to zero. Your Mac won't give up - it won't be able to go 

'boing' any more, so it will flash the menu bar when you do something 

daft. How obliging of it. 

Change your name, fast 
Tired of waiting for folder and file names to highlight 

rJ®—when you're trying to highlight them? Try clicking on the 

file/folder and straight away moving the mouse slightly 

- the name highlights immediately (or hit the Return key). Once 

you've changed the name, you don't have to click somewhere else to 

make the change permanent - just hit the Enter or Return key. 

Quick copying 
Making copies of files or folders in new locations is a bit of a pain. 

First you have to duplicate the file/folder (command-D) and then drag 

it to its new location and maybe take the words 'copy of' out of its 

name. There's a dramatically quicker way. Simply hold down the 

option key while you drag the item to its new location. Hey presto - 

identical files, and even with the same name. 
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Files and folders 

Synchronising folders 
If you keep one Mac at home and another at the office, and you keep 

duplicate 'work' folders, you're going to want to make sure they're 

both up to date. You can simply replace one folder with another, but 

this does mean that items in the older folder you've deleted in the new 

one will be lost. So open up the latest folder and drag its contents into 

the old one. If the same item exists in both folders, your Mac will ask 

you whether you want to overwrite the old one with the new, or vice 

versa - this way you maintain a full set of all the files you've worked 

on, and the most up-to-date version of each. 

Changing your mind 
If you've started dragging or copying a file/folder from one location to 

.mother, and then changed your mind, drag it up to the menu bar, and 

your Mac will pretend the whole thing had never happened. 

Using icon views for your folders makes your 

Desktop look pretty, but it's frustrating that 

they don't sort themselves out alphabetically - 

they just stay where you plonk them. Ah, but 

if you hold down the option key when you go 

to the Special menu, the Clean up Window 

option has changed to Clean up by Kind (or 

whichever was the last list view you used)... 

Selecting multiple icons 
To select more than one icon (for dragging or deleting lots of 

files/folders at once), select the first normally and then hold down the 

shift key while you select the rest. Or, if there are only a couple of 

items you don't want to select, do a Select All (command-A) first and 

then shift-click on the ones you don't want. 

Closing all the windows 
To close all open folder windows at once, hold down the option key 

while you click on the close box of any single window. 

Ordered icons 

Empty Wastebasket 

Eject Bisk KE 
Erase Oisk... 

Restart 

Shut Bourn 
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Moving windows 
You can move a window that isn't active without making it active. 

Simply hold down the command key as you drag it. 

Keeping it tidy 
If you want a folder that's buried about ten layers deep in your hard 

drive, you can either put up with having nine folder windows stacked 

up behind the one you finally want, or hold down the option key as 

you double-click the successive folders. This closes the parent folder as 

soon as the new folder is open. 

Tracing your parents 
You've been super-efficient. You've 

only got one folder window open on 

your Desktop. But now you need one 

of the folders further up in that 

window's hierarchy - what do you do 

that won't mean about thirty-seconds'- 

worth of window opening and closing? 

Hold down the command key and click 

on the title to get a pop-up menu of all 

the parent folders and simply select the 

one you want. 

A different view 
It7s nice that you can view folder contents alphabetically, or by size, or 

by date, kind or label. Its even nicer that you don't have to haul the 

mouse pointer up to the View menu to do it. Providing you are not 

currenly viewing by icon (and that the folder window is wide enough) 

you can simply click on one of the categories in the header bar to 

choose that view. 

Rapid expansion 
In list views you can examine the contents of folders as an outline. We 

know that clicking on a right-facing arrow turns it downwards and 

displays, indented, a list of all the folder's contents. What we may not 
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Folder views 

know is that by holding down the option key while clicking on the 

arrow expands all the various sub-levels of folders too. We also may 

not know that we can select all of the folders in our folder window 

(command-A) and hit command-option-right arrow to do the same 

trick with all of them at once. 

Get me out of this! 
If your Mac has got stuck in a rut carrying out a task, or you're just fed 

up of waiting - and there isn't a Cancel button in sight - hit 

command-, (full stop) or even the Esc key. 

Instant wipe-out... 
...well, nearly instant. 

If you want to erase a 

floppy disk, hold 

down command- 

option-Tab while you 

insert it (it helps if you have recently broken all your fingers in a freak 

accident) and you go straight to the Do-you-want-to-erase-this-disk 

dialog. Well, it could save you three or four seconds maybe... 

Get that floppy out! 
To eject a disk without having to haul it down to the wastebasket, 

select it and then hit command-E. Use command-Y to avoid leaving a 

ghost image of the disk. If you hit shift-command-1, the disk doesn't 

even need to be selected (but you are left with a ghost image). 

Get lost! 
I .ocked files are a pain because when you try to empty them from the 

wastebasket they won't go. Hold down the option key while you select 

Empty Wastebasket, though, and your problem's solved! 

Getting back to normal 
If you've hopelessly mucked up your control panels, you can get 

everything back to the defaults by holding down command-option-P-R 

while you start your Mac up. 

A 
Completely erase the disk named “UB4 

book backup” that you just inserted? 

[ Cancel ] 
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Make it snappy 
Using the Views control panel you can make files and folders snap to 

an invisible grid as you move them. It keeps things neat, but it can 

leave icons a little widely-spaced. And it's a bit of a nuisance to haul 

yourself over to the control panels to change the setting. Anyway, you 

might like to know that by holding down the command key as you 

drag you reverse the current settings until you release the mouse 

button again. 

Hiding other applications 
If you only want the current application to be visible (i.e. no other 

windows lurking behind it), you can choose Hide Others from the 

applications menu - but it happens automatically if you hold down 

the option key while you select your application. 

Or use some other 

Extensions/control panels- 

handling application. For each job 

you do on your Mac, many of its 

control panels. Extensions and 

fonts are redundant. If you create 

sets of Extensions needed for 

specific tasks and disable the rest, 

you can save a lot of RAM (it's 

not hard to save 1Mb or more). It 

does mean restarting your Mac 

every time you swap Extension sets, but overall you can save yourself 

a lot of time which would otherwise be spent twiddling your thumbs, 

waiting for your Macintosh. 

Upgrade or die 
If you don't have System 7.5, get it now! It's true that it takes 

IB J up a fair bit of hard disk space, but in this day and age most of 

system ug aren't struggling too much to find room on our hard drives. 

And it's a myth that it gobbles up RAM - unless you install bloated 

Use Extension Manager! 

H Extensions Monoger . a 

Sets: | Custom !!

Extensions 
Us* this control panel to turn Conflict Extension** ||| 

you vill 6* *61* to boot your A/ROSE 
Moolntosh corrootly 

!!Apple CO-ROM 

this control panel may oaus* !!AppleScript** 
problems vrth your Macintosh. 

!!At Ease 7 3 Layer Patch | 

CameraMan** Extension | 

!!Colour Plotter 
!!Colour SV Pro 

( Undo ] 

( Help ] 

!!Dragging Enabler 
face Span Extension s 

!!FaxMonttor 
!!FaxPrint 
!!File Sharing Extension 
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Upgrading your System 

. »ptions like QuickDraw GX and PowerTalk, it doesn't use up 

ignificantly more RAM than 7.0 or 7.1. So do it now! System 7.5 

incorporates heaps of fixes and features that people were screaming 

i > »r in earlier versions (and which software companies were charging 

i >u good money to provide). 

Quick file access 
If you have 

System 7.5, 

move a folder 

alias into the 

Apple menu, 

make sure 

Submenus is 

switched on in 

the Apple 

Menu Options 

control panel 

and luxuriate 

in the 

hierarchical 

iib-menus that appear in the Apple menu - you can dig out files and 

folders buried up to five levels deep without having to let go of the 

mouse button. If you select a folder, you go back to the Desktop so 

that the folder window can open; if you select a file, it's the same as 

ilouble-clicking on it. 

Get tooled up 
It you have a CD-ROM drive, buy a copy of The Little Mac Toolkit 

i Publishers: Peachpit Press, Author: Clay Andres, ISBN:1-56609-042-3). 

t his 550-page book comes with a CD-ROM containing hundreds of 

top PD/shareware utilities for everything from converting weird file 

lormats to providing hierarchical pop-up folder menus anywhere on¬ 

screen (it's true). As well as telling you how to use each and every 

program, the book also gives some real insight into how your Mac and 

its operating system work. 
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Macformat subscriptions 

Subscribe to 

FREE Textures for Professionals (worth £93 inc 
VAT) when you subscribe 
Toxtures for Professionals includes 360 seamless textures in 640 x 480 

i < solution and 60 element images at 1,024 x 768 in both TGA and TIFF 

! rinats. Textures include: stone, river rocks, adobe, petunias and 

i nu ms, rocks - including crushed shale and pebbles, dirt and grass, 

i nrs and bark, 32 wood patterns, five fences, 12 granites, dozens of 

11 mi nates, vinyls, flowers and water; 27 varieties of food - including 

< liocolate, chips, red chilli peppers and spinach noodles; 40 fabrics, 

M.x>r coverings, tiles, metals, prints, shingles, stripes and clouds, old 

i .icked leather, nuts and bolts and alligator skin. 

PLUS you have Britain’s best-selling Mac magazine 
delivered to your door every four weeks, and you 
can save money on every issue of Macformat! 

Eight FREE issues 
Hy subscribing to Macformat now, you'll get a FREE copy of Textures 

i Professionals worth £93 inc VAT, and you can make a saving of 

* W.60 if you take out a two-year subscription. That's 24 issues for the 

price of 16! 

To take advantage of this money-saving offer, fill in, cut out and return the 

form on the reverse of this page. No stamp required. 

(>f fcr ends: 31st January 1996 
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The Mac may be friendly, but what if you’re 

new to it all? This practical book tells you all 

you need to know, from the basics of using a 

mouse and menus to icons and folders, then 

shows you how to get to grips with aliases, 

control panels and System extensions. It’s 

packed with helpful advice and tips that will 

benefit even Mac veterans. 

Free with Macformat 33, January 1996 

Not to be sold separately 


